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 Folder Guard Overview

Thank you for choosing Folder Guard for Windows 95 !

Folder Guard is a software-only security solution for personal or publicly accessible computers running 
the Windows 95 operating system.    Its features include:

· Complete control over access to folders of your choice.    You can hide any folder, so that its contents 
will be invisible to all applications including Explorer, MS Office, MS-DOS programs, common dialogs,
etc.  

· Optional logon validation, which helps protect your Windows 95 files from intruders. A log file can be 
set up to help you keep track of the use of your computer.

· Password access to protected folders that can be set up, or changed, at any time. 

· Flexible control of user access to many Windows 95 resources, such as the Start Menu, Control 
Panel, etc. 

· User-specific access rights to folders and to other Windows 95 resources that you can configure 
separately for each user of your computer.  

· Easy and intuitive user interface that helps you set up the attributes of folders you want to protect, 
and helps you control other settings, as well. 

· Protection that’s transparent to both users and applications.    While protecting specified folders and 
other resources, Folder Guard uses only about 30K of RAM.

· Help screens for each feature of Folder Guard.    You can access Help from individual dialog boxes or 
from the main menu.

· Designed to operate with or without the use of System Policies, on a stand-alone computer or on a 
network.

Why do you need Folder Guard to control access to your computer? Doesn’t Windows 95 itself allow you 
to set up restrictions or hide a folder? Well, it does, but in very limited ways.    Read on.…

Hiding folders

When you hide a folder using only Windows 95, that folder will indeed be invisible in an Explorer 
window.    However, anyone using your computer can easily make the folder visible again by choosing
View - Options in the menu bar of Explorer and selecting the “Show all files” option. 

With Folder Guard, when you hide a folder, it actually becomes invisible to all applications.    To make 
the folder visible again, you must either enter a valid password or logon as a user who has access to 
that particular folder.

Making folders read-only

Suppose you want to make a folder read-only — and all you have is Windows 95. You select that 
folder in an Explorer window, then press Alt+Enter to see the properties of the folder, and check the 
“Read-only” checkbox on the property page.    Okay, what is the result?    Windows 95 does not 
prevent you from creating new files or deleting existing files in this folder.    You are still able to modify 
any or all of the files within the folder.    You can create new subfolders or delete existing ones.    In 
other words, you have the same full access to the folder, as before.    The only change is that if you 



rename a read-only folder, Windows 95 prompts you to confirm the command; and if you choose 
“Yes”, the folder is renamed.

With Folder Guard, you can truly make a folder “read-only”.    The files in such a folder will be 
available for reading and executing, but all other operations — such as creating new files or 
subfolders, renaming or deleting the existing ones, modifying the contents of the files — will not be 
performed.

Monitoring the logon

You can use the built-in capabilities of Windows 95 to setup passwords for multiple users working with
your computer.    The problem is, however, that unless your computer is connected to a secure 
network, anyone can logon to Windows 95 as a new user — simply by typing a new user name at the 
logon prompt.    Or an unauthorized user can just press the Cancel button at the logon prompt and 
start using the computer as the “default” user.

Folder Guard provides a means to validate every user’s name before letting him or her log on to 
Windows 95.    Also, you can optionally disable the “Cancel” button on the Windows logon prompt or 
set up a separate password for the “default” user.    This helps ensure that authorized users are the 
only ones able to access Windows 95 on your computer.

Permissions

Folder Guard allows you to restrict access not only to folders, but also to some other Windows 95 
resources, such as Control Panel, commands of the Start Menu, items on the Desktop, the Run and 
Shut Down commands, etc.

You will find Folder Guard indispensable if you share your computer with others and you don't want any 
changes made to your files.    Or, if you allow your kids to play games on your system from time to time, 
and want to be sure that everything will be OK when they finish.    Or, if you don't want your parents to see
some of your files.    Or, if you are a network administrator and your users give you a headache messing 
the files up all the time. However you use Windows 95, you may have concerns about the security, 
privacy, or confidentiality of your files.    And now you have a single, effective solution — Folder Guard.

WARNING: Folder Guard is a powerful tool that should be used with care.    Please take time reading 
Folder Guard Help before enabling the protection of folders!

Folder Guard includes an automatic Setup utility, allowing you to painlessly install and uninstall Folder 
Guard.    Extensive context-sensitive Help provides a complete user's guide to Folder Guard.

"The way software should be!"(tm)

Related topics:
Folder Guard Help Contents
What's new in this version
System requirements
This is "Try Before You Buy" software
How to order a license for continued use of Folder Guard



 What Folder Guard does NOT do

Folder Guard is a powerful, but not an omnipotent, tool.    Here are some important limitations you should 
be aware of before you start using Folder Guard:

· Folder Guard cannot restrict access to generic “virtual” folders. Only “real” folders — those folders 
which actually exist on your disk(s) — can be restricted with it.    Folder Guard, however, does provide
a way to restrict some common “virtual” folders, such as Desktop and Control Panel (see permissions
in this Help for more information).

· You cannot use Folder Guard to set up different access rights to different files in the same folder.    If 
you restrict a folder, all files contained therein are restricted in the same way.

· The protection of folders is not activated if you boot Windows 95 in the “safe” or “command prompt 
only” mode.    You can restrict booting Windows 95 in these modes, though, by modifying the 
MSDOS.SYS file.

· Folder Guard does not protect folders from system tools which directly access the contents of the 
drives.    You can, however, prevent access to such tools by placing them in hidden folders.

· Folder Guard does not protect network resources, except for the shared folders mapped to a drive 
letter.    To protect other resources, use the built-in security features of the network.

· Folder Guard cannot protect your computer from a hammer, fire, or robbery <g>.
 
Note:    Folder Guard helps you protect files and folders from the prying eyes of    most Windows 95 users.
This protection, however, is not intended to withstand attack by anyone who has sufficient time (that is, 
unsupervised access to your computer) and expertise.



 What's new in this version

Version 4.04 (June 23, 1997)

Feature(s) added:

- The functionality of the Folder Guard shortcut menu is enhanced: if you right-click on the "visibility" 
icon for a folder in the Folder Guard window, only the part of the context menu that controls the 
visibility of the folder will be displayed. Similarly, right-clicking on the "access" icon of a folder displays
the "access" commands of the shortcut menu.    If you right-click on the name label of a folder, the full 
shortcut menu is shown.

- A list of users has been added to the "Permissions" dialog box, to make you able to set up the 
permissions for different users without closing and re-opening the dialog box.

- The "Permissions" button has been added to the toolbar. 

Bug(s) fixed:

- Running FGuard.exe from a different folder doesn't prompt for the Administrator's password.

- When user profiles are not enabled but the "Logon Validation" option is turned on, then closing 
Windows causes an application error in the Explorer.

- Invalid page fault in Shell32.dll during setup if Internet Explorer 4.0 is running.

- The folder protection cannot be disabled if IE4 is running.

Version 4.03 (June 5, 1997)

Feature(s) added:

- The procedure of the logon validation is improved: It does not use a separate logon prompt 
anymore. The validation is now performed using the "native" Windows logon prompt.    This not only 
simplifies the procedure but also solves the compatibility problems with some networks;

- New miscellaneous options added: “Preset system folders” and “Autoscan subfolders”. 

Bug(s) fixed:

- User name is not fully validated if the "DontDisplayUserName" Windows option is set by a third party
software tool;

- Revoking the "Allow save desktop settings" permission does not have effect;

- Revoking the "Allow addition and deletion of printers" does not prevent from adding printers;

- “FGUARD caused an invalid page fault in module FGUARD.EXE at 014f:00406196.”;

- The folder protection is not enabled if no folder has the "visibility" attribute different from its "default" 
visibility;

- The administrator’s password is stored in the local registry instead of the CFG file.



Version 4.02 (February 25, 1997)

Feature(s) added:

- A log file can be now set up to keep track of users working with the computer;

- The time dependencies of the FGA and FGD files are now checked;

- No more than one instance of FGuard.exe can now be running at a time;

- New command added to the File menu: Build All

- More screens added to the Folder Guard Advisor.

- The documentation is updated.

Bug(s) fixed:

- The permissions for the Default User are not saved in the FGA file.

- Incorrect default title of the prompt for the default user's password while validating user name at 
logon. 

Version 4.01 (February 8, 1997)

The first release of Folder Guard for Windows 95. 



 System requirements

Folder Guard is designed for the Windows 95 operating system.    It will NOT install or work under 
Windows NT (you can use the built-in security features of Windows NT instead to control access to the 
folders).    At least 1 MB (one megabyte) of free space on your hard disk is required to install Folder 
Guard.    Folder Guard can be used both on a stand-alone computer and on a network.



 This is "Try Before You Buy" software

Folder Guard is NOT free or “public domain” software. It is Try Before You Buy software. This means 
that you may use the program during 14 days (not necessarily constituting a contiguous sequence) to 
evaluate it and determine whether Folder Guard is suitable for your needs. At the end of this trial period, 
you must either register (purchase a license for continued use of the program) or discontinue using 
Folder Guard. For complete text of the evaluation use license please refer to file VENDINFO.DIZ, 
included in the Folder Guard distribution package.

Related topics:
Evaluation vs Continued use
What do you get when you order a license for Folder Guard
How to order a license for continued use of Folder Guard
How to enter your Registration Code



 Evaluation vs Continued Use

There is NO functional difference between the evaluation and the licensed versions of Folder Guard:    all 
features of the licensed version are available and can be used in the evaluation version.    Actually, it's the 
same program:    you may convert an evaluation copy to a registered copy by entering your name and a 
Registration Code.    Similarly, a registered copy of Folder Guard may be “unregistered” by deleting the 
Registration Code, or just by copying the program to another computer.

The only difference between the licensed and evaluation versions is the prompt to disable Folder Guard, 
displayed by the evaluation version from time to time:

While you are evaluating Folder Guard, you may reply “No” to this prompt and Folder Guard will continue 
its normal operation, restricting access to the folders you have chosen to protect.    If someone else is 
using the computer, though, that user may reply “Yes” to this prompt and thus restore access to the 
protected folders.

To prevent this prompt from being displayed, you must register Folder Guard — either by supplying a 
valid Registration Code at the end of the installation procedure, or by entering the Registration Code with 
the “Help | About” command of Folder Guard.

To obtain a Registration Code, you must purchase a license for continued use of Folder Guard.    Please 
refer to the ORDER.TXT file for detailed instructions and order forms.    You may order Folder Guard with 
a check or money order.    Major credit cards are accepted.    You may also register via CompuServe.    
Purchase orders from companies are also accepted.

Please refer to ORDER.TXT for more information.

Related topics:
This is "Try Before You Buy" software
What do you get when you order a license for Folder Guard
How to order a license for continued use of Folder Guard



 What do you get when you order a license for Folder Guard

1. A unique Registration Code, allowing you to remove the "Disable Folder Guard" prompt.

2. Disk with the latest version of Folder Guard and information about other ChaoSoft products.

3. The privilege to upgrade to all future versions of Folder Guard for Windows 95 FREE of charge.

4. FREE 90-day customer support.

5. FREE CompuServe membership with a $15.00 usage credit. This is more than enough online time to 
have your technical support questions answered, and still have some fun!

Related topics:
This is "Try Before You Buy" software
How to order a license for continued use of Folder Guard
How to enter your Registration Code



 How to order a license for continued use of Folder Guard

The easiest way to order this software is with a credit card, through a link to a secure web page at:    
http://www.chaosoft.com    or    http://www.pik.com.    The advantages of this method of ordering are as
follows: 

- as soon as the credit card transaction is complete, you are receiving back your personal registration
code, allowing you to get rid of the registration reminder;

- you are provided with a link to immediately download the latest version of the software;

- you save on the shipping charges (since there is nothing left to be sent to you by snail mail).

Alternatively, run Folder Guard, choose the “Help - About” command in the menu, and click on “Order...” 
in the “About Folder Guard” screen (or run Notepad and open file Order.txt , located in the folder where 
Folder Guard has been installed). Then follow the directions contained in the order form.

You may order Folder Guard with a check or money order. Major credit cards are accepted. You may also 
place your order via the CompuServe’s SWREG service. Purchase orders from companies are also 
accepted.

Related topics:
This is "Try Before You Buy" software
What do you get when you order a license for Folder Guard



 Obtaining updates to Folder Guard

You receive the latest version of this program after you order a license for its continued use.

You can also obtain an updated evaluation copy of Folder Guard and use the same Registration Code to 
convert it into a registered version.    The evaluation copies of Folder Guard are available from many 
sources, including FTP and WWW sites, online services (CompuServe, AOL, etc.), BBSes, and from disk 
or CD-ROM vendors.    Some of these sources are listed below:

Internet:
http://www.chaosoft.com (ChaoSoft’s Home page)
http://www.pik.com (Pik A Program, Inc.)
http://www.asp-shareware.org (Association of Shareware Professionals)
http://wugnet.com/compuserve/winuser.html (WinUser forum on CompuServe)
http://www.hotfiles.com (Ziff-Davis Interactive Software Library)
ftp://ftp.pik.com
ftp://ftp.asp-shareware.org
ftp://ftp.simtel.net/pub/simtelnet  

(search for the keyword CHAOSOFT using any search engine on the Web for more links)

CompuServe:
GO PIKAPROG, or WINSHARE, or WINUTIL, or WUGNET, or WINUSER
search for the keyword CHAOSOFT



 Getting customer support

Before requesting customer support, *PLEASE* check out the on-line Help for Folder Guard. In particular,
be sure to look through the Answers to Frequently Asked Questions section.

If you cannot find the information you need in the documentation, then choose the support option that’s 
right for you:

1) For TECHNICAL questions — about program features, bug reports, suggestions on improving the 
program, etc. — please contact the author of Folder Guard, Andrei Belogortseff, directly via e-mail at:

Internet: 74634.2173@compuserve.com
Compuserve: 74634,2173

In your message, please include information about versions of Windows and Folder Guard you are 
using and a detailed description of the problem.    A reproducible sequence of steps leading to the 
problem would be of most help.    Please do not send any files to this address unless you have been 
instructed to do so.    

2) For NON-TECHNICAL questions — about the status of your order, sales terms, pricing and discount 
information, etc. — please contact the authorized dealer at:

Pik A Program, Inc.          
13 Saint Marks Place        
New York, NY 10003            
USA                                          

Telephone (212) 598-4939
Fax (212) 228-5879
E-mail: sales@pik.com
CompuServe: 74777,3233



 How to access Folder Guard Help

You can access Help for Folder Guard in several ways:

· By clicking on the Start button in the taskbar and choosing Folder Guard Help from the Folder 
Guard submenu of the Programs menu (this option is available only if you have chosen the “Add
items to Start Menu” option while installing Folder Guard).

· By opening the Folder Guard Help shortcut from the Folder Guard folder on the Desktop (this 
option is available only if you have chosen the “Add folder to desktop” option when installing 
Folder Guard).

· By using commands from Help menu while running Folder Guard.

· By opening file FGuard.hlp, located in the folder in which you have installed Folder Guard.

· By clicking on the Help button in any dialog    box displayed by Folder Guard.
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  How to install Folder Guard

· If you have obtained Folder Guard as a compressed file, uncompress the file into a temporary folder on 
a hard disk, or on a floppy diskette.

· Open folder containing the uncompressed set of Folder Guard files and double-click on “Setup”. 

Note: If you have a previous version of Folder Guard already installed on your computer and have set up 
the administrator  ’  s password  , you will be prompted for this password to continue the installation.    
Setup may also prompt you to restart Windows before the installation can be continued.

· When the “Welcome to Folder Guard!” screen appears, click on the “Next” button to switch to the 
“Install” page:

· Now click the “Install...” button and Setup will copy Folder Guard files into the destination folder. It will 
also add several items to Start Menu and create a folder named “Folder Guard” on the Desktop with 
shortcuts to Folder Guard files (unless you have cleared corresponding checkboxes in    the “Install” 
page).

Note: Except for the files copied into the destination folder and, optionally, for the shortcuts added to the
Start Menu and/or to the Desktop folder (as described above), Setup does not install or modify any 
other files on your computer.

· At the end of the installation procedure Setup prompts you to enter your name and a Registration Code.
If you have purchased a license for continued use of Folder Guard and received your Registration 
Code, you may enter it at that time, and the evaluation version of Folder Guard will be converted into 
the licensed (registered) one.    Otherwise, you may skip entering the Registration Code and Folder 
Guard will be configured to operate in the evaluation mode.

· After the installation has been complete, you may delete all the files from the temporary folder, from    
which you have run Setup.exe.

Note: At this point Folder Guard, although installed, in no way affects the operation of your computer.    



That is, all folders can be freely accessed, as before, and no other restrictions are imposed on the use of 
the computer.    To enable the protection of folders you must run Folder Guard (FGuard.exe) and use its 
commands to specify how exactly you want your computer to be protected.

Related topics:
Using Setup utility
Quick Start Guide



 Using the Setup utility

Folder Guard comes with a convenient and flexible Setup utility,    which allows you to install and uninstall 
Folder Guard.

To run Setup, open folder in which you have placed the Folder Guard files and double-click on “Setup”. A 
dialog box will appear, containing a number of pages. 

Tip To switch between the pages without performing any installation steps, click on the corresponding tab at the top 
of the dialog box or use the Ctrl+PgUp and Ctrl+PgDn keys.

The Setup dialog box contains the following pages:

Welcome
This page is for information purposes only.    Pressing the Enter key or clicking on the “Next” button 
while this page is active does not perform any installation steps and simply causes Setup to switch to 
the “Install” page.

Install
Use this page to specify the installation options.    Pressing the Enter key or clicking on the “Next” 
button while this page is active performs the installation steps specified and switches to the 
“Register” page.

Register
Use this page to enter your Registration information.    If you have obtained Folder Guard for 
evaluation purposes and do not have your Registration Code yet, simply click OK or press Enter, and 
Folder Guard will be configured for use in the evaluation mode.    If you have purchased a license for 
continued use of Folder Guard and have received your Registration Code, you may enter it at this 
time. 



 ”Welcome” Page of Setup

This page is for information purposes only.    Pressing the Enter key or clicking on the “Next” button while 
this page is active does not perform any installation steps; it simply causes Setup to switch to the “Install”
page.



 ”Install” Page of Setup

Use this page to specify installation options for Folder Guard.    This page has the following areas:

Existing installation
Information about the version number and folder in which the existing installation of Folder Guard is 
detected, if any.

File set being installed
Information about the version number and location of the Folder Guard files being installed. 

Installation steps to perform
Installation options. Setup suggests you these options based on the information about the existing 
installation of Folder Guard and the file set being installed.

Copy files to the new location
If checked, this option causes Setup to install Folder Guard files into the folder specified in the 
“Destination folder” field on this page.    Choose this option if you are installing Folder Guard for 
the first time, or if you want to move an existing installation into another folder.    If the files are 
already located in the destination folder, you may clear this checkbox.

Activate all components
If checked, this option causes Setup to update the Windows 95 configuration so that it will 
recognize and use Folder Guard components.    Choose this option if you are installing Folder 
Guard for the first time, or if you want to move an existing installation into another folder.

Add items to Start Menu
If checked, this option causes Setup to add a group of menu items related to Folder Guard to 
Windows 95 Start Menu, under the name “Folder Guard” .    You may clear this box if you don’t 
want such items to be added to the Start Menu.    If you are moving an existing installation of 
Folder Guard into another folder and the “Folder Guard” group already exists, check this box to 
force Setup to update the group according to the new location of the Folder Guard files.

Add folder to Desktop
If checked, this option causes Setup to add a folder with shortcuts related to Folder Guard to the 
Desktop, under the name “Folder Guard”.    You may clear this box if you don’t want such a folder
to be created.    If you are moving an existing installation of Folder Guard into another folder and 
the “Folder Guard” folder already exists, check this box to force Setup to update its shortcuts 
according to the new location of the Folder Guard files.

Destination folder for Folder Guard files
The folder in which Folder Guard files are to be installed.    You may accept the default folder 
suggested by Setup, or choose another one, by clicking on the “Browse” button or by typing the full 
path to the folder directly into the edit box.    If the “Copy files to the new location” checkbox is 
cleared, the contents of this field is ignored by Setup and the destination folder is assumed to be the 
folder from which you have run Setup.exe.

Note: Pressing the Enter key or clicking the “Install” button while the “Install” page is active causes 
Setup to perform the installation steps specified.    If you want to display a different page of the Setup 
dialog box without performing any installation steps, click on the corresponding tab at the top of the dialog
box or use the Ctrl+PgUp and Ctrl+PgDn keys to switch between different pages.



 ”Register” Page of Setup

This page displays the current registration information for Folder Guard.    You may use this page to enter 
your Registration Code, if you have purchased a license for continued use of Folder Guard.    If you do so,
the evaluation version of Folder Guard will be converted into the registered one.

If you are installing Folder Guard for evaluation, simply skip entering the registration information by 
pressing Enter or clicking OK or Close.



 Uninstalling Folder Guard

Note: It is NOT sufficient to simply delete files from the Folder Guard folder in order to completely 
uninstall it.    Please follow the procedure described below to uninstall Folder Guard and clean up your 
system configuration:

1. Open Control Panel.

2. Double click the “Add/Remove programs” icon. 

3. When the dialog box appears, make sure that the “Install/Uninstall’ page is selected.

4. Select the “Chaosoft Folder Guard” line in the list of software that can be uninstalled.

5. Click the “Add/Remove” button.

Note: If you have set up the Administrator  ’  s password  , you will be prompted for this password to 
continue. You may also be prompted to restart Windows before the uninstallation can be continued.

The Uninstalling Folder Guard dialog box will appear, prompting you to confirm that you want to uninstall 
Folder Guard.    At this time, you may choose to deactivate all Folder Guard components, delete its files, 
delete user files related to Folder Guard, and/or reset Folder Guard settings. Press the Help button in this 
dialog box for more information on the options offered.

We hope you will change your mind!



 ”Uninstalling Folder Guard” dialog box

This dialog box is displayed by Setup when you request Windows 95 to uninstall Folder Guard. You can 
use it to specify the desired uninstalling options.

The dialog box has the following areas:

Deactivate all components
When checked, this option causes Windows 95 to disable folder protection, if it is currently enabled, 
and to remove other information related to Folder Guard from the local Windows 95 Registry.    Also, 
this option removes the “Folder Guard” submenu from Start Menu, and the “Folder Guard” folder 
from the Desktop, if they have been created during the installation.

Delete application files
When checked, this option causes Folder Guard to delete its executable and auxiliary files from the 
folder in which Folder Guard has been installed.    This option does NOT delete user files (such as 
FGA files), that is the files which you may have modified.    

Delete user files
When checked, this option causes Folder Guard to delete user files from the folder in which Folder 
Guard has been installed.    User files are the files which you may have modified, that is the FGA files. 
If you plan to re-install Folder Guard later on, you may wish to keep such files for future use.    In such 
a case, clear this checkbox and all *.FGA files in the Folder Guard folder will be kept undisturbed 
during the uninstall process.    Note also, that if you do want such files to be deleted and check this 
option, only the folder in which Folder Guard has been installed is searched for the *.FGA files.    If 
you have created FGA files in other folders, you will need to delete them on your own.

Reset user settings
When checked, this option causes Folder Guard to delete its FGuard.cfg file, and, therefore, to reset 
its settings (e.g., clear history lists, reset positions of windows used by Folder Guard, re-initialize 
options, etc.).    If you plan to re-install Folder Guard later on, you may wish to keep this information 
for future use.    In such a case, clear this checkbox. 

Note: If you want to completely uninstall Folder Guard and clear all Windows 95 resources it uses, check 
all options offered.

Note: If you want to temporarily deactivate Folder Guard, check only the first option, Deactivate all 
components.    This will retain all the Folder Guard files on your disk but prevent Windows 95 from 
using them.    To re-activate Folder Guard later on, run Setup.exe from the folder in which Folder 
Guard has been installed and choose “Activate all components” in the “Install” page.

Note: If you plan to re-install Folder Guard, check only the first two options, “Deactivate all components” 
and “Delete application files”.    This will uninstall Folder Guard, but keep the user files (such as FGA 
files) on your disk undisturbed, so that you will be able to use them again when you re-install Folder 
Guard.



 Quick Start with Folder Guard
This section is intended to help you get started with Folder Guard.    If you don’t like reading manuals, or 
don’t want to use all features of Folder Guard, or just want to give Folder Guard a test run, this is a good 
place to start.

Here you’ll find step-by-step instructions on how to use Folder Guard to achieve a simple (and, probably, 
most common) goal: preventing unauthorized access to the contents of a specific folder on your 
computer.    After you have performed the steps described below, a folder of your choice, as well as all 
files and subfolders contained therein, will be hidden and inaccessible for all users of your computer.    
Only you will be able to gain access to the folder at any time by entering a valid password.

Throughout this section, a sample folder — one you want to prevent others from accessing — is called 
“C:\A Private Folder”.    If you want to restrict some other folder(s), make appropriate adjustments while 
following the instructions.

Step 1. Getting your system ready.
Step 2. Installing Folder Guard.
Step 3. Starting Folder Guard
Step 4. Assigning attributes to the folder
Step 5. Setting up the passwords
Step 6. Saving the changes and building FGD file(s)
Step 7. Setting up the automatic enabling
Step 8. Testing Folder Guard
What you may wish to do next...
If anything goes wrong...



  Step 1. Getting your system ready

First of all, a word of warning:    Folder Guard is a powerful tool and should be used responsibly.    Using it
thoughtlessly, you can inadvertently make your computer inaccessible.    For example, it is very easy with 
Folder Guard to prevent access to the Desktop folder, and make Windows 95 load with a blank screen 
after you boot. 

Before you begin using Folder Guard, backup the Registry.    By the way, it is a good practice to backup 
the Registry and other important Windows 95 files before installing any new software.    The procedure 
itself takes only a minute or two, but it will save you hours if anything goes wrong.    Folder Guard comes 
with a simple MS-DOS batch file, REGISTRY.BAT, which you can use to automate Registry backups and 
restores.    You can backup the Registry before or after you have installed Folder Guard.

Also, make sure you can boot Windows 95 in “Safe” mode. Folder Guard is not enabled at Windows 95 
startup in “Safe” mode, so you will be able to bypass it and correct any problems.



  Step 2. Installing Folder Guard

You have probably already installed Folder Guard. If not, click here for a brief review of the installation 
process.



  Step 3. Starting Folder Guard 

Now run Folder Guard. You can do this by clicking on the Start button in the Windows 95 Taskbar and 
choosing Programs => Folder Guard => Folder Guard in the Start menu.    Or, by opening the Folder 
Guard folder created on your Desktop during the installation of Folder Guard, and double-clicking the 
Folder Guard shortcut.    One more way to start Folder Guard is to open the folder in which you have 
installed Folder Guard, and double-click on the FGuard.exe file.

No matter which way you choose, the main window of Folder Guard should appear on your screen:

The window shows the hierarchy of folders on your computer, beginning from “My Computer”. Of course, 
your computer may have a different combination of drives than the ones shown here.



  Step 4. Assigning attributes to the folder

Before Folder Guard can hide or otherwise protect the folder you have chosen, you must let Folder Guard
know which folder you want to protect, and how exactly you want Folder Guard to protect it.    The way to 
supply this information to Folder Guard is by specifying the attributes of the folder you want to be 
protected. First of all, take a look at the toolbar located at the top of the window (right below the menu 
bar). 

The following group of buttons is used to specify how you want a folder to be accessible to the users:

 Full access
Makes all files contained in the folder accessible without limitations, as if Folder Guard were not 
present.    Users can open files in this folder, modify them and save them back into the same 
folder, rename or delete files and subfolders, etc. 

 Read-only access
Allows opening files in the folder, so that their contents may be viewed, but prevents saving 
modifications to the files into the same folder.    This also prevents creating, deleting, or renaming 
files or subfolders. 

 No access
The same restrictions as above, plus prevents opening files even for reading.    That is, the 
contents of the folder can be viewed in an Explorer window (unless you have restricted its 
visibility, see below), but cannot be accessed or modified in any other way.

The following group of buttons is used to control the visibility of a folder and its contents when users 
browse your computer with Explorer or other similar application.

 Visible
Makes all files and subfolders contained in the folder, as well as the folder itself, to be visible to 
the user.

 Restricted
Leaves the folder itself to be visible in an Explorer window, but hides all files and subfolders 
contained therein, unless a subfolder is explicitly set to be visible. 

 Hidden
Unconditionally hides the folder itself and all files and subfolders it contains.

 
Now use these buttons to assign the desired attributes to the folder you have chosen to restrict.    Keep in 
mind, however, that at this point no actual protection is taking place.    The protection will begin as soon as
you enable it, later on.    At this point you are only specifying how you would like the folder to be protected.

Use your mouse or arrow keys to highlight “A Private Folder” under drive C:, and click on the buttons No 
access and Hidden (each of the buttons will remain depressed after you click them):



That is, you have instructed Folder Guard to prevent all access to the folder, and hide the folder and its 
contents from browsing.    Notice that the icons next to the name of the folder have changed, reflecting the
attributes you have just assigned.    Notice also that the name of the folder is now shown in a bold 
typeface; this indicates that the folder has non-default attributes assigned to it.



  Step 5. Setting up the passwords

Folder Guard uses two passwords:

Administrator’s password
You are prompted for this password whenever you run Folder Guard or its Setup utility.    If you fail to 
set up the Administrator’s password, anyone using your computer can run Folder Guard.

Folder access password
Allows a user to disable the protection of folders at run time by running FGKey.exe.    If this password 
is not set up, the only way to disable the protection at run time is by running Folder Guard.    You will 
probably want to set up this password to access the protected folder(s) for your own use while the 
protection is enabled for other users.

The commands to set up the passwords are located under the File menu of Folder Guard.    Of course, 
you can use the same word for both of these passwords, if you wish.



  Step 6. Saving the changes and building FGD file(s)

Now, when the attributes of the folder you want to protect and the passwords have been set up, choose 
the File - Save command from the menu, to save the changes in an FGA file on the disk.    When the Save
As dialog box appears, enter a name for the file (for example, FGuard.FGA) and press OK.    

Folder Guard will save the file and prompt you to activate the file you just have saved.    Reply Yes to this 
prompt, and Folder Guard will generate the FGD file(s) necessary for its work.



  Step 7. Enabling the protection on Windows 95 startup

Now choose File - Settings in the menu bar of Folder Guard:

Check the Folder Protection option and press OK. (Do not worry about other options of this dialog box 
—    you will be able to use them later on). 

Now everything is set up, and you may exit Folder Guard. 

Before closing, Folder Guard will prompt you to confirm that you want the protection of folder(s) to be 
enabled automatically at Windows 95 startup. Choose Yes to continue.

You may also be prompted to enable the folder protection.    You may reply Yes to this prompt and Folder 
Guard will start to protect the folder(s) you have chosen immediately upon its exit.    If you reply No to this 
prompt, the protection will be enabled only after you reboot Windows.



  Step 8. Testing Folder Guard

If you have enabled the protection (as described in the previous step), Windows loads the Folder Guard 
driver FGuard.VxD, which reads data from the FGD file(s) and starts to protect folder(s).

The driver also attempts to find the registration information for Folder Guard.    If you are still evaluating 
Folder Guard and have not purchased a license for its continued use, such information does not yet exist.
In this situation, Folder Guard shows the following prompt:

You may reply No to this prompt and Folder Guard will continue its normal operation, restricting access to
the folder(s) you have chosen with Folder Guard.    If someone else is using the computer, though, that 
user may reply Yes to this prompt and thus restore access to the protected folders.

To verify that Folder Guard does prevent access to the folder you have chosen, run Windows 95 Explorer 
and make it display the contents of the C: drive.    The folder you have restricted with Folder Guard (“A 
Private Folder” in our example) should not appear among other folder you may see in the root folder of 
the C: drive.    If, however, you see this folder, go back to Step 3 and repeat the procedure.

Now run Notepad (or any other Windows 95 application which uses Common Dialogs to open and save 
documents) and choose File - Open from its menu.    Make the Open dialog box to display the contents of 
the C: drive; “A Private Folder” should not be visible in the listing either.

Try also to view the contents of the root directory of the C: drive using the MS-DOS prompt window (or 
run any other MS-DOS program that allows browsing the directories). The folder you have protected with 
Folder Guard should not appear in the directory listing (unless you have run the program after switching 
Windows 95 into the MS-DOS mode).

Now, as you have made sure that “A Private Folder”    is indeed hidden and inaccessible, try to restore 
access to it. Click on the Start button in the taskbar and choose Programs => Folder Guard => Toggle 
Folder Protection or run FGKey.exe from the folder in which you have installed Folder Guard. You will be
prompted to enter your folder access password, and, if you have entered it correctly, the protection of the 
folder will be disabled.    Now try to find “A Private Folder” using Explorer (you may need to press F5 in an
Explorer window to refresh its contents), the folder should become visible again, and you should be able 
to access its contents.

To re-enable the protection of the folder, you do not have to reboot Windows 95. Click on the Start button 
in the taskbar and choose Programs => Folder Guard => Toggle Folder Protection again.    After you 
have replied Yes to the prompt to enable the protection, “A Private Folder” should disappear from the 
folder listing again (you may need to press F5 in an Explorer window to refresh its contents). 

This is how Folder Guard works. 



  What you may wish to do next...

If you want to set up protection for other folders on your computer, or change attributes of the previously 
protected folders, you can do so with Folder Guard.    You do not have to disable the protection before 
running Folder Guard:    as part of its initialization process, Folder Guard checks the status of the 
protection, and, if it is enabled at that time, disables it.    When you exit Folder Guard, it automatically re-
enables the protection. 

When setting up attributes of the folders, keep in mind that a folder may have no attributes assigned (that 
is, have “default” attributes).    The visibility and access rights to such a folder are determined by the 
attributes of its “parent” folder.    For example, if you assign the “read-only” access to a folder, all its 
subfolders with “default” attributes will have “read-only” access, too.    Whenever possible, try to reduce 
the number of folders with “non-default” attributes; doing so will increase the efficiency of work performed
by Folder Guard while protecting the folders.

Also please be aware that Windows 95 treats the “My Computer” folder, as well as the drive folders, 
slightly differently than the “real” folders.    If you assign the “hidden” attribute to “My Computer” or to a 
drive, it will NOT be hidden in an Explorer window.    To hide these items, you must use additional means 
provided by Folder Guard, the permissions, which you can control with the Edit - Permissions command. 

While working with Folder Guard, you may wish to explore its possibilities by using its context-sensitive 
Help.    In most dialog boxes, press the Help button, and a Help screen with information related to the 
dialog box will open. 

With Folder Guard, it is possible to set up different attributes of the folders for different users of your 
computer (you must enable user profiles to let different users log on to Windows 95 using their own 
names and passwords).    To set up the protection of folders for a specific user, select that user’s name in 
the User List. Then use Folder Guard commands to set up the desired visibility and access rights of the 
folders for the selected user.    While making the changes, keep in mind that if a folder’s attributes are set 
to be “default” for the current user, the attributes of that folder set for the “Default User” will be used 
instead.    The icons displayed next to the folder names show the resulting attributes of the folders for the 
current user.

With Folder Guard, you can control access not only to folders, but also to some other Windows 95 
resources. You can do this by using the Edit - Permissions command of Folder Guard. The permissions 
provided by Folder Guard are equivalent to a subset of the system restrictions, which you can set up 
using the System Policy Editor. 



  If anything goes wrong...

If you have set up Folder Guard so that the folder protection is enabled at Windows startup, and Windows
95 fails to boot properly, this means that Folder Guard is incompatible with some hardware or software 
already installed on your computer.

In such a case, try to boot Windows 95 in the "safe" mode (by pressing F8 while the "Starting Windows 
95..." text is shown on the screen and choosing "safe mode" from the menu).    After Windows 95 loads in 
the "safe" mode, run Folder Guard and turn OFF the "Enable at Windows startup: Folder Protection" 
option. This should make Windows bootable again.

Alternatively, boot Windows in the "command prompt only" mode    or from a bootable floppy disk.    When 
the command prompt appears, change directory to the folder in which you have installed Folder Guard 
and rename FGuard.VxD to some other name, for example, FG.VxD.    Then try to boot Windows as 
usually, ignoring the message about a missing FGUARD.VXD driver.

After Windows 95 is ready to use, open the "Add/Remove Programs" icon in the Control Panel, and 
uninstall Folder Guard.



 Terminology

Folder Guard can be a lot of fun to use. But like any "game”, unless you know the rules and have seen it 
played, it can be difficult to feel comfortable the first few times.

The "rules" of Folder Guard are explained in the Help screens which follow. The Quick Start Guide helps 
you set up the program and gives you a basic feel for how the program is operated.

Throughout this Help, the term “Folder Guard” has two slightly different meanings, depending on the 
context in which it is used:

· First, Folder Guard is used to refer to all files and tools included with the software. For example, the 
phrase “installing Folder Guard” refers to the entire set of associated files.

· Second, Folder Guard is used to refer to the main application, the FGuard.exe file.    This meaning is 
assumed in phrases like “running Folder Guard” or “a command of Folder Guard”.

 
Folder Guard (as a whole set) is used to perform two separate (although related) tasks:

· You, the Administrator of the computer (or a computer site), are using the main application of Folder 
Guard, FGuard.exe,    to specify which folders and other Windows 95 resources should be protected, 
and how exactly you want them to be protected.    We refer to this process as running Folder Guard.

· While other users work with the computer, Folder Guard performs the protection of folders according 
to the decisions you made. Help refers to this process as the protection.

The following terms are also used:

Players Description
You You are the Administrator. You decide how other users may access and view the 

information stored on your computer.    You run Folder Guard to set up the access rights 
to the folders, and enable/disable the protection, when needed.

User The end user who uses your computer.    When the protection is enabled, Folder Guard 
monitors the user’s activity and restricts or allows access to the folders according to the 
attributes you have assigned. 

Tools Description

Explorer The file management component of Windows 95, Explorer lets you work with files, 
folders, and subfolders — as well as drives and network connections.    Help uses 
Explorer to refer solely to this particular Windows 95 component, and NOT to the 
Microsoft Internet Explorer.

FGuard.exe Folder Guard, the main application you use to assign desired attributes to the folders on 
your computer and control other settings of Folder Guard.

FGKey.exe A utility allowing you (or anyone else who knows the folder access password) to turn on 
and off the protection of folders performed by Folder Guard.    

FGuard.VxD The virtual device driver that actually performs the protection.



 Running Folder Guard

You can run Folder Guard by choosing the “Folder Guard” item in Windows 95 Start Menu, by opening 
the “Folder Guard” shortcut in the folder created on the Desktop during the installation of Folder Guard, 
or directly, by opening file FGuard.exe in the folder where you have installed Folder Guard.

When you run Folder Guard, it analyzes the structure of folders on your computer and displays them in its
main window. Using commands of Folder Guard, you can specify how folders can be accessed and/or 
viewed by the user by assigning appropriate attributes to selected folders. The attributes are stored in an 
FGA file. Based on this information, Folder Guard prepares FGD files to be used by its driver, 
FGuard.VxD, when you enable the protection. The following diagram illustrates the interaction between 
these components of Folder Guard:

 



 Folder Attributes

In addition to the standard attributes of folders (Read-only, Archive, Hidden, System), maintained by 
Windows 95 itself, Folder Guard allows you to specify additional attributes of folders. The attributes 
defined by Folder Guard are divided into two groups —    the access attributes and the visibility attributes.

Folder Access Attributes
Attributes Description
Full Access Permits files stored in the folder and its subfolders to be opened, modified, renamed, 

deleted, etc. When you specify Full Access, any user will be able to access the folder and
all its contents in all the ways that you can do so.

Read-only Allows the opening files in the folder, so that their contents may be viewed, but prevents 
saving any modifications to the files into the same folder.    Also prevents creating, 
deleting, or renaming files or subfolders.

 
No Access Imposes the same restrictions as the read-only attribute, plus prevents the opening of 

files even for reading.    Therefore, when you specify No Access, a user can view the 
contents of the folder in an Explorer window (unless you have restricted its visibility, see 
below), but the user cannot access or modify the individual files in any other way.

Folder Visibility Attributes
Attributes Description
Visible Makes all files and subfolders contained in the folder, as well as the folder itself, to be 

visible in an Explorer window.

Restricted Leaves the folder itself to be visible in an Explorer window, but hides all files and 
subfolders contained therein, unless a subfolder is explicitly set to be visible.

 
Hidden Unconditionally hides the folder itself and all files and subfolders it contains.

Note: Throughout this documentation, unless otherwise noted, “attributes” refers to the Folder Guard 
Attributes, not to the standard file/folder attributes maintained by Windows 95.    Folder Guard 
Attributes are completely independent from the standard folder attributes, even though some of them 
have the same names.    You may view and /or modify the standard folder attributes by selecting the 
desired folder in an Explorer window and pressing Alt+Enter (or, by choosing “Properties” in the 
Windows 95 shortcut menu). 

A folder may have “default” attributes.    Such a folder inherits the attributes from its parent folder.    For 
example, if you assign the Read-only attribute to a folder, this attribute is also applied to all its subfolders 
which have the “default” access attribute.    Likewise, if you make a folder Hidden, all its subfolders with 
the default visibility attribute will be considered hidden as well, unless you explicitly assign some other 
visibility attribute to a subfolder.    There is one exception to this rule:    assigning the “Restricted” attribute 
to a folder makes all its subfolders Hidden by default.    This is consistent with the description of the 
“Restricted” attribute given above.

You can assign attributes to the folders by running Folder Guard and using its Edit - Access, Edit - 
Visibility, and Edit - Attributes commands.    You can access these commands via menu bar, Toolbar or 
Shortcut menu.

You don’t have to assign one or another attribute to every folder on your computer. You will probably want
most folders to have the “default” attributes, and assign some other attributes only to those folders you 
want to restrict.





 Folder Guard Window

When working with Folder Guard, you can see that names of some folders are shown in its window in 
bold typeface.    This indicates that such a folder has a non-default attribute assigned to it.    Names of 
folders which have only “default” attributes are displayed in the regular typeface.
    

The icons shown next to the names of the folders represent their attributes:

Folder Access Attributes:

 Full access
 Read-only access
 No access

Folder Visibility Attributes:

 Visible
 Restricted
 Hidden

If you change an attribute of a folder, its icons also change to reflect the new attributes of the folder.    
Note that while you are assigning the attributes, no actual protection of folders is performed, unless you 
have built the FGD files and have explicitly enabled the protection.    

Whenever you use Folder Guard to create a new FGA file, Folder Guard assigns the “default” attributes 
to all folders, and, unless you have turned off the Preset system folders option, it assigns the “Full 
access” and “Visible” attributes to some system folders.    Click here for more information on this 
procedure.



 Passwords

Folder Guard allows you to set up two different passwords:

Passwords Description
Administrator’s If you set up this password, Folder Guard will prompt you to enter it whenever you run 

Folder Guard or its Setup utility.    You must also enter the old Administrator’s password 
before changing it.    If this password is not set up, Folder Guard and Setup can be run by 
any user. The Administrator’s password is stored in the FGuard.cfg file.

Folder Access If you set up this password, you will need to enter it whenever you want to disable the 
protection with FGKey.exe (represented by the “Toggle folder protection” item in the Start
Menu).    If the password is not set up, FGKey.exe does not prompt for it and leaves the 
protection of folders enabled. The folder access password is stored in the FGA and FGD 
file(s), along with the folder attributes.

To set up the passwords, use the File - Password commands of Folder Guard. Of course, you may use 
the same word for both passwords, if you wish.

Note: The length of a password must be between 1 and 64 characters. Any characters are allowed, including 
spaces and punctuation.    The passwords are case sensitive:    If, for example, you have chosen the word 
“Apple” as the password, Folder Guard will not accept the words “APPLE” or “apple” as the valid passwords.



 User List

Folder Guard allows you to specify different attributes of folders for different users of your computer.    To 
set up folder protection for a specific user, you must first add the user’s name to the User List, and then 
use Folder Guard commands to assign desired folder attributes and permissions to the user.    Of course, 
you must also enable and create user profiles for each users before Windows 95 lets them to log on 
under their names.

User List is initially not shown in the Folder Guard window; to make it visible, use the View - User List 
command in the menu bar.    The user list initially appears as a separate toolbar, but you can drag it with 
the mouse to any other place on the screen.

Tip You can switch the input focus between the main window of Folder Guard and User List by pressing any of 
the following keys: TAB, F6, CTRL+F6.

The User List initially contains a single entry, “Default”, created by Folder Guard automatically whenever 
you create a new FGA file.    This entry is always present in the User List; you cannot delete or rename it.  
You can use this entry to set up folder attributes and permissions common to all users of your computer.

To add additional entries to the User List, or modify the existing ones, use the Edit - User List command of
Folder Guard.    To set up the attributes of folders or permissions for a particular user, select this user’s 
name in the User List.    Folder Guard will automatically update its window to reflect the attributes of 
folders as they have been assigned for the selected user. 

When specifying the folder attributes for different users, remember the following rule:    If you assign the 
“default” attribute to a folder for a particular user, the attribute of this folder which was assigned for the 
“Default” user will be used instead.    You can take advantage of this feature to simplify your work:    First 
assign the attributes of folders which are common to all users of your computer to the “Default” user, then
use other entries in the User List to specify those attributes applicable to each user. 

You don’t have to add all users of your computer to the User List:    If a user logs on to Windows 95 under 
a name not listed in the User List, the settings specified for the “Default” user will be applied. 



 Permissions

Folder Guard allows you to restrict the user’s access not only to folders, but also to some other Windows 
95 resources.    You can accomplish it with Folder Guard by assigning desired permissions to the users.

The permissions provided by Folder Guard are divided into two groups:

General
used to specify the user’s access to some common elements of the Windows 95 user interface and 
tools, such as the Start Menu, Control Panel, etc.

Drives
used to control the visibility of the drive icons in the shell windows, such as My Computer.

To set up the permissions, use the Edit - Permissions command of Folder Guard.

To set up the permissions for a particular user, first select the user's name in the "User" list.

To allow the user to access a resource, click the box next to the appropriate text in the list of permissions 
until a check mark appears on the box: .    To restrict the user’s access to the resource, make the cross 
mark appear on the box: 

.    To prevent Folder Guard from affecting the user’s access to the resource (that is, to assign the 
“default” permission), make the box appear grayed: 

.

If you are familiar with System Policies, you will notice the similarity between the permissions provided by 
Folder Guard and the restrictions provided by System Policies.    For example, the permission “Include 
‘Run’ command in Start menu” corresponds to the restriction “Remove Run command”.    In fact, Folder 
Guard permissions represent a most common subset of restrictions available with System Policies. 

You don’t have to use Folder Guard permissions if you are already using restrictions provided by System 
Policies.    You may find, however, that using Folder Guard permissions is more convenient:



· With Folder Guard permissions, you can hide specific drive icons in My Computer. System Policies 
allow you only to hide or show all drive icons as a group;

· Folder Guard provides more flexible control over permissions assigned to different users.    For 
instance, if you assign the “default” permission to a resource for a specific user in the User List, the 
permission assigned to the resource for the “Default” user is applied instead.    This is in contrast to 
the algorithm used by System Policies — if a policy for a specific user exists, the policy for the Default
user is ignored altogether.

· If the set of permissions provided by Folder Guard is sufficient for your needs, you don’t have to 
install and configure System Policies.    Of course, if you want to set up restrictions to other resources,
you must use System Policies. 

Note: Although permissions provided by Folder Guard are similar to the restrictions provided by System 
Policies, the two are completely independent.    You may use Folder Guard permissions and System 
Policies simultaneously on the same computer, if you wish.    Remember, however, that non-default 
Folder Guard permissions take precedence over the corresponding restrictions provided by System 
Policies.    If, for example, you have set up System Policies to remove the “Run” command from the 
Start Menu, and at the same time set up Folder Guard permission for the same user allowing him or 
her to have the “Run” command in the Start Menu, then the “Run” command will be included in the 
Start Menu when this user logs on to Windows 95.

Note: Some permissions (such as “Show all desktop icons” ) take effect only during the logon and 
therefore the access to the resource cannot be restored by running FGKey.exe.

    



 FGA files

Folder Guard uses files with extension FGA to store the folder attributes between its sessions.    After you 
have assigned the attributes, Folder Guard prompts you to save the changes in an FGA file.    When you 
run Folder Guard next time, you can open the file and restore the attributes of folders.

In addition to the folder attributes, Folder Guard also stores in the FGA files the list of users (if any) you 
have added to the User List, the permissions assigned to each user, and the folder access password.

In most cases it is sufficient to have only one FGA file to store the information, but you may wish to create
several such files, containing different data, to be used on different occasions. 

To simplify and automate your work, you may find it convenient to assign one of the FGA files (usually the 
file you use most often) to be the “active FGA file”. 



 FGD files

FGD files contain information about the attributes of folders and permissions for a particular user.    Each 
of these files is prepared by Folder Guard in a format understandable by the Folder Guard driver, 
FGuard.VxD.    In addition to the folder attributes, an FGD file also contains the following information, 
needed by FGuard.VxD to efficiently perform the protection:

· For each folder that you have chosen to be protected, both its long file name and the 8.3 alias (MS-
DOS name) are stored.

· For root folders of the network drives, the UNC name of the drive is stored as well.

· If your computer contains only one floppy drive, then the attributes you have assigned to the A: drive 
are duplicated for the B: drive (and vise versa), to prevent users from accessing the floppy drive using
an alternative drive letter.

· The folder access password (encoded) is placed into the FGD files as well.

Folder Guard generates FGD files when you use the File - Build or File - Build All command. (The File - 
Build All command is also executed automatically by Folder Guard when you save the active FGA file). 

A separate FGD file is generated for each user listed in the User List, and placed into the working folder.    
Each FGD file is named for a particular user (that is, the user for which the FGD file was generated), and 
the FGD extension is appended to the file name.    For example, Folder Guard places data for the Default 
user into the Default.FGD file.    Similarly, if the User List contains the name “John”, Folder Guard will 
place data for this user into the John.FGD file.

Note: While generating an FGD file for a particular user, Folder Guard examines the folder attributes 
and permissions assigned to this user, and compares these values to those assigned to the Default 
user.    If all such user settings are identical to the settings for the Default user, Folder Guard 
generates a 0-length FGD file for this user.    When performing the protection for such a user, Folder 
Guard uses the Default.FGD file.    This approach enables Folder Guard to operate more efficiently.    
You cannot alter this default behavior.



 Active FGA file

When you need to make changes to the folder attributes with Folder Guard, you usually go through the 
following steps:

· Running Folder Guard (FGuard.exe).
· Opening the FGA file in which you have saved the attributes of folders last time.
· Making changes to the folder attributes.
· Generating the FGD files with the File - Build All command.
· Saving the changes to the FGA file.
· Exiting Folder Guard. 

Folder Guard allows you to automate several steps of this cycle by supporting the “Active file” paradigm.   
If you assign the status of “Active file” to the FGA file you are using (or to one of such files, if you have 
created several of them), Folder Guard does the following:
    
· Whenever you run Folder Guard, it automatically opens the active file for you during its initialization.    

Thus you don’t have to remember which FGA file you used last time, and don’t have to manually 
open it. 

· Whenever you save the active file, Folder Guard automatically performs the File - Build All command 
for you, generating the FGD file(s). This keeps the FGD files consistent with the active FGA file.

Now you have a more streamlined way of working with Folder Guard:

· Running Folder Guard (the active FGA file is automatically opened for you at startup).
· Making changes to the attributes of the folders as desired.
· Saving the file (the FGD files are automatically updated as well).
· Exiting Folder Guard.

To set up the active FGA file and control other related settings, use the File - Settings command of Folder 
Guard.



 Working folder

Working folder is the folder which contains files used by Folder Guard while it is performing the protection.
By default, Folder Guard chooses the folder in which it has been installed to be the working folder. You 
have the option of assigning a different folder for this purpose, if you like, by using the File - Settings 
command of Folder Guard.

The working folder must contain the following files:

· The FGuard.VxD file.
· The FGuard32.DLL file — if the Enable Logon Validation at Windows startup option is used.
· The FGKey.EXE file — if the Enable Logon Validation at Windows startup option is used.
· All the FGD files generated with the File - Build All command.
· The FGuard.UNM file — if it has been generated by Folder Guard.



 To protect or not to protect?

When deciding which folders you want Folder Guard to protect, consider the following issues:

· The folder in which Windows 95 is installed (usually C:\Windows) must always have the “full access” 
attribute.    If you assign the “read-only” or “no access” attribute to this folder, Windows 95 will not 
load successfully.

· Most subfolders of the folder in which Windows 95 is installed (usually C:\Windows) must have their 
access attribute set no higher than “read-only”.    You can try assigning “no access” and “hidden” 
attributes to such folders, but first make sure you have backed up the Registry.

· Many Windows 95 applications on your computer are installed into subfolders of the Program Files 
folder (usually C:\Program Files).    If you restrict access to this folder, the applications installed in its 
subfolders may become inaccessible.

· You can assign the “no access” and “hidden” attributes to the working folder of Folder Guard.    
However, if you want to be able to disable the protection of your system with FGKey.exe, make the 
working folder “read-only” and “restricted”. 

· If you assign the “restricted” attribute alone to a folder, it does not make the folder inaccessible.    The
contents of such a folder will be invisible for Explorer, but the user will still be able to access files in 
the folder by other means, such as shortcuts.    To make the contents of a folder inaccessible, use the 
“no access” attribute as well.

 



 Setting up for multiple users

If you want several users to work with your computer, you will probably want to assign separate folders for
each of the users, in which they would keep their personal files. For example, if your computer is to be 
used by two users, Mike and Susan, you may wish to create the following folders:

Now, you will probably want Mike and Susan each to have full access to the files in their own folders (C:\
Users\Mike for Mike and C:\Users\Susan for Susan).    But you also probably want Mike and Susan each 
to have no access to folders assigned to any other user.    You can do this by running Folder Guard and 
assigning appropriate attributes to the folders:

· First select the root folder common to all users (C:\Users in our example), select the “Default” user in 
the User List, and assign the “No access” and “Restricted” attributes to the folder:

· Now select “Mike” in the user list, select the folder you have assigned to Mike (C:\Users\Mike), 
and set the “Full access” and “Visible” attributes for this folder:

· Repeat the above step for Susan, assigning the “Full access” and “Visible” attributes to her 
private folder.

Now, after you build the FGD files and enable the protection, Mike and Susan will have access only to his 
or her private subfolder of the C:\Users folder; neither will be able to see or modify files in the subfolders 
assigned to other users. 

You may also wish to set up in the same way the system folders used by Windows 95 to store personal 
settings of each user.    Such folders are usually created by Windows 95 as subfolders of the Profiles 
folder (usually C:\Windows\Profiles).    However, you must enable the Logon Validation at Windows 
startup option if you have decided to protect such folders.    This will let Folder Guard properly manage the
access to these folders during the logon process.





 Monitoring the logon process

If you have enabled user profiles on a stand-alone computer, Windows 95 displays the logon prompt and 
verifies the user’s password before letting that user begin a Windows 95 session.    This feature, however,
does not make your computer secure:

· Any user can type a new name in the logon prompt. Windows 95 will simply allow this user to logon 
under the new name.

· Any user can press the Cancel button in the logon prompt (or press the Escape key).    Windows 95 
permits this user to logon as the “default” user — without requiring a password.

Even if the computer is connected to a secure network, it is sometimes possible to bypass the network 
logon procedure and start using the computer in a stand-alone mode, without logging on to the network. 

With Folder Guard, you can overcome these shortcomings of Windows 95 by enabling the Logon 
Validation at Windows startup.    You can set up Folder Guard to validate the name entered by the user in 
the Windows logon prompt, and thus prevent from logging on under a new name.    You can disable the 
Cancel button on the Windows logon prompt or set up a logon password for the default user.    You can 
also customize the texts of the messages displayed by Folder Guard, while monitoring the logon.

Note:    If you turn the Logon Validation option on, Folder Guard monitors the Windows logon prompt, 
appearing on the screen after Windows 95 boots up or after the primary network logon prompt is closed.   
Folder Guard does NOT monitor the network logon prompt.

Note:    In order for a user name to be considered valid by Folder Guard, this user must have logged onto 
the computer at least once, before you enable the “Validate user name” option.    If you need to add a 
new user to the computer, you must first clear the “Enable folder protection at Windows startup“ option.    
Then, after rebooting Windows 95, use the standard Windows 95 logon prompt to let Windows 95 create 
entries for the new user name(s).    Having done that, run Folder Guard and turn the “Enable folder 
protection at Windows startup” option on again. 



 Giving your computer "bullet-proof" protection

The following recommendations will help you prevent others from bypassing the protection of folders 
performed by Folder Guard:

· Restricting access to Registry editing tools.    A user can disable the protection by editing the 
Registry and then rebooting Windows.    You can deny users access to the Registry Editor by using 
permissions provided by Folder Guard or by setting up appropriate restrictions with the System Policy
Editor. Keep in mind, however, that you will similarly need to restrict access to the Registry editing 
components of third-party utilities on your computer (if any).

· Restricting access to the working folder of Folder Guard.    While setting up folder attributes with 
Folder Guard, assign the “read-only” attribute to the working folder of Folder Guard.    This will 
prevent other users from deleting or modifying Folder Guard files.

· Preventing users from running MS-DOS programs in the MS-DOS mode.    You can achieve this 
by setting up the appropriate permission provided by Folder Guard or by using the Windows System 
Policies.

· Preventing users from booting Windows 95 in the “safe mode” or “command prompt only”.    
Because the protection is not enabled at Windows 95 startup in either of these cases, it is important 
to restrict a user’s ability to boot Windows 95 in any of these modes.    You can force Windows to boot
in the GUI mode only by modifying the MSDOS.SYS file, located in the root folder of the boot drive.    
Be sure to have a text editor on a bootable floppy disk, so that you will be able to modify this file and 
boot Windows 95 in the “safe mode” or “command prompt only”, if needed.

Note:    Folder Guard helps you protect files and folders from the prying eyes of    most Windows 95 users.
This protection, however, is not intended to withstand attack by anyone who has sufficient time (that is, 
unsupervised access to your computer) and expertise.



 Using backup and disk utilities

The protection of folders performed by Folder Guard may confuse some of the system utilities, such as 
backup or disk managing software.    For example, if your backup software allows you to specify which 
folders to backup, and you leave the protection in effect during the backup, the folders you've made 
invisible or restricted with Folder Guard may not be backed up.    On the other hand, if the backup 
software stores a complete image of a disk disregarding its folder structure, it may be safe to leave the 
protection on, since Folder Guard does not prevent the direct access to the disk sectors.

The disk scanners, defragmenters, and optimizers also should be used with care.    Although our tests 
show that the folder protection can be left ON during the work of the built-in disk managing tools of 
Windows 95, as well as with Norton Disk Doctor and Norton Speed Disk, we strongly advise you to turn 
the protection OFF before running such tools.    

To test a disk utility for compatibility with Folder Guard, run the utility twice, with the folder protection 
turned OFF and ON, and make the utility test the disk integrity during each run. Do not fix any disk 
errors during the tests!    If the reports generated are identical, i.e. they both show no errors (or the 
same errors), the utility may be compatible with Folder Guard.    If, however, the utility reports more disk 
errors while the folder protection is in effect, it is not compatible with Folder Guard. You should never run 
it while the folder protection is in effect, otherwise you are at risk of disk corruption and/or loosing files.

If you discover such a utility, please let us know!



File menu commands

The File menu offers the following commands:

New
Creates a new FGA file.

Open
Opens an existing FGA file.

Save
Saves an opened FGA file using the same file name.

Save As
Saves an opened FGA file to a specified file name.

Password
Allows to set up the passwords used by Folder Guard.

Build
Builds *.FGD file(s) for all or a specific user in the User List.

Build All
Builds *.FGD file(s) for all users in the User List.

Settings 
Opens the Folder Guard Settings dialog box.

Exit    
Exits Folder Guard.



New command (File menu)

Use this command to create a new FGA file in Folder Guard. 

You can open an existing FGA file with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing FGA file in Folder Guard. 

You can create new menu files with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



Save command (File menu)

Use this command to save an FGA file you are editing to its current name.    When you save a file for the 
first time, Folder Guard displays the Save As dialog box so you can name your file.    If you want to 
change the name and location of an existing file before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the FGA file you are editing.    Folder Guard displays the Save As 
dialog box so you can name the file.    

To save a file with its existing name, use the Save command.



Password commands (File menu)

Use these commands to set up the passwords used by Folder Guard. 



Build command (File menu)

Use this command to generate the FGD file(s) for all users or for a specific user in the User List. When 
you choose this command, Folder Guard displays the Build dialog box. 

Shortcuts

Toolbar:
Keys: CTRL+B



Build All command (File menu)

Use this command to generate the FGD file(s) for all users in the User List. 

Shortcuts
Keys: CTRL+D



Settings commands (File menu)

Use these commands to change settings for Folder Guard. When you choose this command, Folder 
Guard displays the Folder Guard Settings dialog box. 

Shortcuts

Toolbar:
Keys: CTRL+E



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four FGA files you 
closed.    Choose the number that corresponds with the FGA file you want to open.



Exit command (File menu)

Use this command to end your Folder Guard session.    You can also use the Close command on the 
application Control menu.    Folder Guard prompts you to save the FGA file, if necessary.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



Edit menu commands

The Edit menu offers the following commands:

Undo
Reverses previous editing operation, if possible.

Cut
Deletes (resets) attributes of the selected folder and moves them to the Clipboard.

Copy
Copies attributes of the selected folder to the Clipboard.

Paste
Pastes folder attributes from the Clipboard into the selected folder.

Reset Folder
Resets attributes of the selected folder to “default” for all users.

Reset User
Resets attributes of all folders to “default” for the user currently selected in the User List.

User List
Opens the Modify User List dialog box.

Permissions
Opens the Permissions dialog box.

Access
Visibility

Modifies attributes of the selected folder for the selected user.
Attributes

Opens the Attributes for the selected folder dialog box.



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove all attributes of the currently selected folder and put them on the Clipboard. 

Cutting data to the Clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy all attributes of the currently selected folder to the Clipboard. 

Copying data to the Clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to replace all attributes of the currently selected folder with the attributes from the 
Clipboard. This command is unavailable if the Clipboard is empty.

Shortcuts
Keys: CTRL+V



Reset Folder command (Edit menu)

Use this command to assign the “default” attributes to the selected folder.

Shortcuts
Keys: CTRL+R



Reset User command (Edit menu)

Use this command to assign the “default” attributes to all folders for the user currently selected in the 
User List.

Shortcuts
Keys: CTRL+U



User List command (Edit menu)

Use this command to manipulate the contents of the User List.    When you choose this command, Folder 
Guard displays the Modify User List dialog box. 

Shortcuts

Toolbar:
Keys: CTRL+L



Permissions command (Edit menu)

Use this command to set up permissions for users.    When you choose this command, Folder Guard 
displays the Permissions dialog box. 

Shortcuts

Toolbar:
Keys: CTRL+P



Access commands (Edit menu)

Use these commands to assign a desired folder access attribute to the selected folder for the user 
currently selected in the User List.



Visibility commands (Edit menu)

Use these commands to assign a desired folder visibility attribute to the selected folder for the user 
currently selected in the User List.



Attributes command (Edit menu)

Use this command to modify the attributes of the currently selected folder.    When you choose this 
command, Folder Guard displays the Attributes dialog box. 

You can also double click on the selected folder to modify its attributes.

Shortcuts
Keys: ENTER

ALT+ENTER



View menu commands

The View menu offers the following commands:

Toolbar
Shows or hides the toolbar.

Status Bar
Shows or hides the status bar.

User List
Shows or hides the User List.

Compact Tree
Collapses all branches which have only subfolders with default attributes; also expands all branches 
which have subfolders with non-default attributes.

Refresh All
Updates the folder tree.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
commonly used Folder Guard commands.      A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (View menu)

Use this command to display and hide the Status Bar.    The Status Bar describes the action that Folder 
Guard will next execute — after you select a menu item or depress a Toolbar button.    It also reports on 
the keyboard state (Caps Lock,    Num Lock,    and Scroll Lock).    A check mark appears next to the menu 
item when the Status Bar is displayed.

See Status Bar for help on using the Status Bar.



 User List command (View menu)

Use this command to display and hide the User List.    A check mark appears next to the menu item when 
the User List is displayed.



 Compact Tree command (View menu)

Use this command to show all folders with non-default attributes, and collapse all folders which contain no
subfolders with non-default attributes. 



 Refresh command (View menu)

Use this command to update the folder tree displayed in the main window of Folder Guard.    Use this 
command after you have renamed or moved a folder with Windows Explorer.

Shortcut
Key: F5



 Tools menu commands

The Tools menu offers the following commands:

Policy Editor
Runs the Windows 95 Policy Editor (PolEdit.exe).

Registry Editor
Runs the Windows 95 Registry Editor (RegEdit.exe).

System Editor
Runs the Windows 95 System Configuration Editor (SysEdit.exe).

Control panel
Opens the Control Panel.

Explorer
Runs Explorer.

Enable/Disable Folder protection
Dynamically loads/unloads the Folder Guard driver, FGuard.VxD.



 Enable/Disable Folder Protection command (Tools menu)

Use this command to dynamically load/unload the Folder Guard driver (FGuard.VxD) and, therefore, to 
enable/disable the protection of folders.    This command is useful for “on the fly” testing of folder 
protection — while you are running Folder Guard.    

Shortcuts

Toolbar:



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics
Presents an index to the topics on which you can get help.

Reset Advisor
Resets Folder Guard Advisor to its original state.

About Folder Guard
Displays the version number and registration information for your copy of Folder Guard.

Note: Press SHIFT+F1 to access the Context Help command of Folder Guard.    When you choose this 
command, the mouse pointer will change to an arrow and question mark.    Then click somewhere in the 
Folder Guard window, such as a Toolbar button.    The Help topic will be shown for the item you clicked.



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions on using Folder Guard and various types of reference information.    

Once you open Help, you can click the Contents button, at any time, to return to the opening screen.



Context Help command 

Press SHIFT+F1 to access the Context Help command of Folder Guard.    When you choose this 
command, the mouse pointer will change to an arrow and question mark.    Then click somewhere in the 
Folder Guard window, such as a Toolbar button.    The Help topic will be shown for the item you clicked.



Reset Advisor command (Help menu)

Use this command to reset Folder Guard Advisor in its original state, so that those messages for which 
you have chosen the “Don’t show this message again” option will start appearing.



Folder Guard Advisor

Folder Guard Advisor is designed to assist you while you are using Folder Guard.    It detects some 
common situations which may require your attention and displays a message describing the situation.    

The message box contains the “Don’t show this message again” checkbox.    If you select this option 
before closing the message box, this particular message will not be displayed again, until you perform the
Help - Reset Advisor command of Folder Guard.    

Each message displayed by Folder Guard Advisor has the “default” reply button associated with it.    This 
button is indicated by a dashed rectangle when the message is initially displayed on the screen.    If you 
have chosen the “Don’t show this message again” option for a particular message, the “default” reply will
be assumed to be chosen by you for this message thereafter. 

Note:    Pressing the Enter key while a Folder Guard Advisor message is displayed is equivalent to 
choosing the first reply button (such as Do It or Yes).    Pressing the Escape key has the same effect 
as choosing the second reply button (such as Ignore or No).    Pressing the Space key is equivalent 
to choosing the button which currently has the focus (indicated by a dashed rectangle).



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Folder Guard.    You
may also use it to open the order form for Folder Guard or enter your registration information. 



 Shortcut menu

Folder Guard offers a shortcut menu which provides quick access to some of the commands of Folder 
Guard.    The Shortcut menu is displayed after you click with the right mouse button within the client area 
of the Folder Guard window.    It offers the following commands:

Access
Visibility
Cut
Copy
Paste
Reset Folder
Attributes

Duplicate commands of the Edit menu



 Keyboard shortcuts

You can use the following keyboard shortcuts while working with Folder Guard:

To Press
Get help on the highlighted menu item F1
Create a new FGA file Ctrl+N
Open an existing FGA file Ctrl+O
Save the FGA file Ctrl+S
Build *.FGD file(s) Ctrl+B
Build All *.FGD file(s) Ctrl+D
Change Folder Guard settings Ctrl+E
Exit Folder Guard Alt+F4
Undo the last editing operation Ctrl+Z, Alt+Backspace
Cut data to the Clipboard Ctrl+X
Copy data to the Clipboard Ctrl+C
Paste data from the Clipboard Ctrl+V
Reset folder attributes Ctrl+R
Reset current user Ctrl+U
Modify User List Ctrl+L
Modify permissions Ctrl+P
Modify folder attributes Enter, Alt+Enter
Refresh folders F5
Switch between main window and User List Tab, F6
Expand the selected folder Right arrow
Collapse the selected folder Left arrow



Toolbar

The toolbar is displayed across the top of the Folder Guard window, below the menu bar.    The toolbar 
provides quick mouse access to some of the more commonly used commands of Folder Guard.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). You can also drag the 
toolbar with the mouse to any place on your screen.

Button Description

Shortcut to the File - New command.

Shortcut to the File - Open command.

Shortcut to the File - Save command.

Shortcut to the File - Build command.

Shortcut to the File - Settings command.

Shortcut to the Edit - Permissions command.

The following buttons provide shortcuts to the Edit - Access commands.    Clicking on any already 
depressed button resets the access attribute of the selected folder to the “default” access.

Full access

Read-only

No access

The following buttons provide shortcuts to the Edit - Visibility commands.    Clicking on any already 
depressed button resets the visibility attribute of the selected folder to the “default” visibility.

Visible

Restricted

Hidden

The following buttons are also included in the toolbar:



Shortcut to the Tools - Enable/Disable Folder protection command.

Shortcut to the Help - About Folder Guard command.

The following button is shown simultaneously with the User List, in a separate toolbar:

Shortcut to the Edit - User List command.



Status Bar

The Status Bar is displayed at the bottom of the Folder Guard window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the Status Bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them (that is, before you release them).    Suppose that, after viewing the description of the 
Toolbar button command,    you decide not to execute the command.    You do this simply by releasing the 
mouse button while the pointer is off that particular button on the Toolbar.

The right areas of the status bar indicate which of the following keys are ON:

Indicator Description
CAP The Caps Lock key is ON.

NUM The Num Lock key is ON.

SCRL The Scroll Lock key is ON.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and file.

To move the window, drag the title bar.    

Note: You can also move dialog boxes by dragging their title bars.



Scroll bars

The Scroll bars are displayed at the right and bottom edges of the window.    Scroll boxes inside the Scroll 
bars indicate your vertical and horizontal location in the file.    You can use the mouse to scroll to other 
parts of the file.



Size command (System menu)

Use this command to resize the active window with the arrow keys.    When you choose the Size 
command, the pointer changes to a four-headed arrow.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move.    

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a move the active window or dialog box with the arrow keys.    When you 
choose the Move command, the pointer changes to a four-headed arrow.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Folder Guard window to an icon.

Shortcut
Mouse: Click the minimize icon on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space on your screen.

Shortcut
Mouse: Click the maximize icon on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.



Restore command (Control menu)

Use this command to return the active window to the size and position it occupied before you chose the 
Maximize or Minimize command.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



 Folder Guard Settings dialog box

Use this dialog box to specify settings for Folder Guard. This dialog box contains the following pages:

Startup
Input
Output
Misc 



 Startup page (Folder Guard Settings dialog box)

Use this page to specify how you want Folder Guard to operate during Windows 95 startup.    This page 
contains the following areas:

Folder Protection
If checked, this option configures Windows 95 so that it loads the Folder Guard driver (FGuard.VxD) 
during its boot process, and thereby enables the protection of folders.
Note:  If you change this option, you must reboot Windows 95 in order for the new setting to take 
effect.

Logon Validation
If checked, this option causes Folder Guard to monitor the logon procedure.    
Note: This option is ignored if the Folder Protection option above is not checked.    Do not use this 
option if your computer is configured so that no logon prompt appears on the screen at the beginning 
of the working sessions of Windows 95. (If you want the logon prompt to be displayed by Windows 
95, you must enable the user profiles ).

Options
Press this button to open the Logon Validation Options dialog box. 
 



 Logon Validation Options dialog box

Use this dialog box to specify how you want Folder Guard to monitor the logon process.    This dialog box 
contains the following areas:

Validate user name
If checked, this option causes Folder Guard to validate the user name during the Windows 95 logon 
procedure.

Don’t show previous user name
If this option is selected, Folder Guard clears the name of the user who logged on to Windows last 
time in the logon prompt.

No Default User
If checked, this option causes Folder Guard to disable the Cancel button on the Windows logon 
prompt and thus prevent from logging on as Default user. 

Ask password
If checked, this option causes Folder Guard to prompt for the Default user logon password, when the 
user presses the Cancel button on the Windows logon prompt.    If you do not check this option, 
Folder Guard lets you logon as the default user — and does not prompt you for the password (unless 
you have checked the No Default User option, see above).

Password
Click this button to set up the logon password for the Default user. 

Log File
If checked, this option causes Folder Guard to write a record in the file specified whenever a user logs
on or off. 

Max. # of lines
The maximum number of records the log file may contain (default is 100).    When the number of lines 
in the log file reaches the maximum value specified, the first record (the oldest one) is deleted from 
the file, leaving room for the more recent records.    Each record takes about 80 bytes in the log file.

Custom texts
Messages displayed by Folder Guard while monitoring the logon. This group contains the following 
areas:

Type
The type of the message.

Default
The default text of the message used by Folder Guard.    This text is not used if the Custom area 
is not empty.

Custom
The custom text of the message.    If this field is empty, the text specified in the Default area will 
be used.

Reset All
Click on this button to clear all custom texts. This will restore the default values for all messages 
displayed by Folder Guard while monitoring the logon process.





 Input page (Folder Guard Settings dialog box)

Use this page to specify the active FGA file. This page contains the following areas:

Active FGA file
Path to the FGA file you want to be active.    If you want no FGA file to be active, clear this box.

Reload at startup
If checked, this option causes Folder Guard to automatically open the active FGA file during its 
initialization.    This option is ignored if no active FGA file has been specified in the Active FGA file 
area.

Activate current file
Check this box if you want the path of file being edited to be inserted in the Active FGA file area.    
This control is disabled if the file being edited has no name (untitled). 



 Output page (Folder Guard Settings dialog box)

Use this page to specify how and where FGD files should be built when you use the File - Build or File - 
Build All commands. This page contains the following areas:

Build *.FGD files on saving the active FGA file
If checked, this option causes Folder Guard to build all *.FGD files every time you save the active 
FGA file. This helps you keep the *.FGD files consistent with the active FGA file.

Working folder
The path to the working folder of Folder Guard. 



 Misc page (Folder Guard Settings dialog box)

Use this page to change miscellaneous options of Folder Guard. This page contains the following areas:

Show full path in the title bar
If checked, this option forces Folder Guard to display the full path of the FGA file being edited in its 
title bar.    If cleared, only the name of the file is displayed in the title bar.

Show ‘splash screen’ at startup
If checked, this option allows Folder Guard to display the “splash screen” with information about 
Folder Guard at its startup. If cleared, you will not see the splash screen at startup.

Re-enable protection at exit
If checked, this option causes Folder Guard to restore the status of folder protection at exit.    That is, 
when you run Folder Guard, it always disables the folder protection.    When you exit Folder Guard, it 
re-enables the folder protection — providing that the protection was enabled before you ran Folder 
Guard.    If this checkbox is cleared, the folder protection remains disabled when you exit Folder 
Guard. 

Prompt to activate FGA file
If checked, this option causes Folder Guard to prompt you to activate the FGA file when you save the 
FGA file under a different name than the one for the currently active FGA file.

Preset system folders
If this option is checked, then whenever you create a new FGA file, Folder Guard automatically 
assigns the “Visible” and “Full access” attributes to the system folders on the computer.    You may 
wish to turn this option off to prevent Folder Guard from scanning the root folders of the drives and 
thus speed up the process of the creation of the FGA files. 

Autoscan subfolders
If this option is checked, then whenever you expand a folder for the first time (by clicking the + sign 
next to the folder’s icon in the Folder Guard window), Folder Guard scans the subfolders of the folder 
being expanded and removes the + signs from the subfolders which themselves do not have 
subfolders.    You may wish to turn this option off to speed up the browsing of the folder tree on the 
computer. 



 Build dialog box

Use this dialog box to generate *.FGD file(s) to be used by the Folder Guard driver, FGuard.VxD, while 
protecting the folders.    This dialog box contains the following areas:

Build *.FGD file(s) for:

All users in User List
When selected, this option causes Folder Guard to build *.FGD files for all users listed in the User
List. This option has the same effect as the File - Build All command.

Selected user only
When selected, this option causes Folder Guard to build an FGD file for the specified user only. 
Note: Whenever you build an FGD file for a particular user, the FGD file for the Default user is re-
built as well.



 Modify User List dialog box

Use this dialog box to manipulate the contents of the User List.    This dialog box contains the following 
areas:

Users
The list of users currently included in the User List.

Add
Click this button to add a new name to the User List.    This will display the Add User dialog box.

Add Existing
Click this button to add a new name to the User List by choosing the name from the list of known 
users of your computer.    This will display the Add Existing User dialog box.

Remove
Click this button to remove the selected name from the User List.

Rename
Click this button to rename the selected name in the User List. This will display the Rename User 
dialog box.

Move Up
Move Down

Use these buttons to change the order of names displayed in the User List.



 Add User dialog box

Use this dialog box to specify the name to be added to the User List. This dialog box contains the 
following areas:

Add new user to the User List
Enter the name of the user in this box.

Choose
Click this button to select the user’s name in the list of known users of your computer.    This will 
display the Choose Existing User dialog box.



 Rename User dialog box

Use this dialog box to change a name in the User List.    This dialog box contains the following areas:

Rename user
Enter the new name in this box.

Choose
Click this button to select the user’s name in the list of known users of your computer.    This will 
display the Choose Existing User dialog box.



 Choose Existing User dialog box

Use this dialog box to choose the user’s name from the list of known users of your computer. 



 Add Existing User dialog box

Use this dialog box to choose the user’s name from the list of known users of your computer.    Click on 
the Add All button to add all known user’s names to the User List.



 Attributes dialog box

Use this dialog box to assign attributes to the currently selected folder.    This dialog box contains the 
following areas:

Path
Shows the full path to the folder which attributes are being modified.

User
Shows the user for whom the attributes of the folder are displayed in the Attributes area. You may 
select any user in this list to modify the attributes of the selected folder for a particular user.

Attributes
Shows the access and visibility attributes of the selected folder for the user selected in the User area.

Reset...
Press this button to assign the “default” attributes to the selected folder for all users.    This is 
equivalent to the Edit - Reset Folder command.



 Permissions dialog box

Use this dialog box to assign permissions for users. This dialog box contains the following pages:

General
Drives

Click on the icons next to the descriptions of the permissions to control the availability of the 
corresponding resources for the user displayed in the "Users" list of this dialog box. 

Icons Description

Makes the resource available for the current user.

Makes the resource unavailable for the current user.

Does not change the availability of the resource for the current user (the “default” availability).

Note: Some of the permissions take effect only after the user logs off and then logs back on to Windows 
95, or after Windows 95 reboots.

Note: If you assign the “default” availability of a resource to any user other than the “Default user”, 
Folder Guard instead uses the corresponding permission assigned to the “Default user”.    The following 
icons are used to represent such permissions:

The resource will be available to the current user since it is made available for the “Default User”.

The resource will be unavailable to the current user since it is made unavailable for the “Default 
User”.

You can use this feature to simplify your work:    First make the assignments of the permissions common 
to all users as the permissions to the “Default user”.    Then assign to the other users only those 
permissions which you want to differ from the permissions set for the “Default user”.



 General page (Permissions dialog box)

Use this page to assign the general permissions to the user currently selected in the User List. 



 Drives page (Permissions dialog box)

Use this page to control the visibility of the drive icons in the Windows 95 shell windows (such as My 
Computer) for the user currently selected in the User List. 

Note: The permissions presented here do not affect the visibility of the root folders on the drives.    Use 
the Folder Attributes to control the visibility of the root folders.



 FGuard.exe
FGuard.exe is the file name of the main application of Folder Guard. You use this application to assign 
desired access rights to the folders and control other Folder Guard settings.    Windows 95 runs 
FGuard.exe when you choose Folder Guard in Start Menu.

With FGuard.exe you can open and save the *.FGA files.    FGuard.exe also generates the following files: 
*.FGD, FGuard.unm, FGuard.cfg, FGuard.lic.

FGuard.exe uses file FGuard32.dll during its operation; the latter must be present in the same folder in 
order for FGuard.exe to operate.

When you run FGuard.exe, it determines whether the folder protection is enabled.    If this is the case, 
FGuard.exe disables the protection — thereby giving you full access to all folders on your computer while 
using FGuard.exe.    When you exit FGuard.exe, it re-enables the folder protection according to the new 
settings, unless you have opted otherwise (by using the Settings command).    



 FGKey.exe
FGKey.exe is a utility allowing you to dynamically enable/disable the protection of folders. 

When you run FGKey.exe without specifying any switches on its command line, it determines whether the
folder protection is currently in effect and acts as follows:

· If the protection is not enabled, FGKey.exe prompts you to enable it.    If you reply “Yes” to the 
prompt, FGKey.exe enables the protection.    

· If the protection is enabled, FGKey.exe prompts you to enter the folder access password.    If you type
in the valid password, FGKey.exe disables the folder protection.    If the folder access password has 
not been set up, FGKey.exe does nothing (that is, it leaves the protection in effect).

You can customize this behavior by using one of the following command line switches with FGKey.exe:

Switch Description
/S Silent operation.    FGKey.exe works in the same way as described above, except that it does not 

prompt you to enable it (the “Yes” reply is assumed), and does not show any messages if its 
operation was successful. FGKey.exe does show the password prompt and error messages, 
though. 

/E Enables folder protection. If folder protection is already enabled, FGKey.exe does nothing, leaving
the protection enabled. 

/D Disables folder protection, prompting for the folder access password.    If folder protection is 
already disabled, FGKey.exe does nothing, leaving the protection disabled.

Note: Only one or no switch can be specified on the command line.    If you specify an invalid switch, 
FGKey.exe ignores it and continues to operate as if you had specified no switch on the command line.

Note: If you have enabled folder protection with FGKey.exe, it will be in effect only until Windows 95 
reboots — unless you have also selected the “Enable Folder protection at Windows 95 startup” 
option in the Settings dialog box. 

FGKey.exe uses FGuard32.dll during its operation; the latter must be present in the same folder in order 
for FGKey.exe to work.



 FGuard.vxd
FGuard.VxD is the core module of Folder Guard.    This is the module which actually performs the 
protection of folders.    FGuard.VxD can be loaded in two ways — statically or dynamically.

Windows 95 loads FGuard.VxD statically during its boot process, if the following key exists in the 
Registry:

HKEY_LOCAL_MACHINE\ System\ CurrentControlSet\ Services\ VxD\ FGUARD

And also, if the string variable “StaticVxD” under this key contains a valid DOS path to FGuard.VxD.    
The path must not contain “long” file names; the 8.3 name aliases must be specified for the “long” 
components of the path.    Folder Guard prepares and writes this variable into the Registry for you when 
you select the “Enable Folder protection at Windows startup” option in the Settings dialog box.    You can 
also add/remove this variable manually, or by using the FGuard.adm file with the Windows 95 System 
Policy Editor.

FGuard.VxD can also be loaded/unloaded dynamically, by running FGKey.exe. 

Whenever FGuard.VxD is loaded (statically or dynamically) into Windows 95 memory, and whenever a 
user logs on or off while FGuard.VxD is loaded into memory, the following occurs:

· FGuard.VxD searches for the appropriate FGD file.    If such a file is found, FGuard.VxD starts to 
protect folders according to the data contained in the FGD file.

· FGuard.VxD searches for the licensing information. If no valid licensing information is found, 
FGuard.VxD starts to display the “Disable Folder Guard” prompt. The interval between the prompts is
first set to 1 minute, then increased to 2, 4, and 8 minutes.



 FGuard32.dll
This file contains common routines used by FGuard.exe, FGKey.exe, and Setup.exe. None of this 
programs will work if the FGuard32.dll file is missing. FGuard32.dll is also indirectly used by FGuard.VxD 
during the logon validation.



 FGuard.cfg
This file is used by FGuard.exe to store its configuration settings between sessions.    FGuard.cfg is 
created when you run FGuard.exe for the first time.    The information stored in FGuard.cfg includes: 
position of the main window of Folder Guard on the screen, positions of its toolbars, options and settings 
of Folder Guard, and the Administrator’s password. 

In order for FGuard.cfg to be used by FGuard.exe, it must be located in the same folder from which you 
run FGuard.exe.    If FGuard.exe cannot find FGuard.cfg, it restores its settings and options to their default
values.    When you exit FGuard.exe, it overwrites file FGuard.cfg with the new settings.

Folder Guard does not store its settings in the Registry (as do many other Windows 95 applications) 
because it is likely to be run by you (the Administrator) while logging onto Windows 95 under different 
user names and, possibly, from different computers (that is, if you are using Folder Guard on a network). 



 FGuard.lic
This file can be used to supply the licensing information for FGuard.VxD when you use Folder Guard on a
large network.

Normally, when FGuard.VxD is loaded into Windows 95 memory, it searches for the licensing information 
in the local Registry.    On a large network, the Administrator can use FGuard.lic to avoid the time-
consuming practice of manually entering the required licensing information into the Registry on each 
computer.    How? Simply by placing this information into the FGuard.lic file.

The FGuard.lic file is created for you automatically when you enter the Registration Code using the Help -
About command of Folder Guard.    However, this file is not created if the number of computers in your 
license is less than 4. 

You may also manually create this file.    For example, if Folder Guard is registered to the name “FooSoft, 
Inc.”, for use on 10 computers, and the Registration Code is 12345, then you can create FGuard.lic as 
follows:

· Run Notepad.
· Enter the name, number of the computers and the Registration Code, separated with vertical lines 

(ASCII character 124), as a single line:

FooSoft, Inc.|10|12345

· Save the file in the working folder, using the name “FGuard.lic” in the Save As dialog box.
· Exit Notepad.

Note: In order for this file to be used by FGuard.VxD, it must be named FGuard.lic and placed in the 
working folder.    It must also contain valid registration information, and the number of computers in 
your license must be 4 or more.    If any of these conditions is not satisfied, FGuard.VxD ignores the 
information supplied by the FGuard.lic file.



 FGuard.unm
This is an auxiliary file, which Folder Guard may create in the working folder while building the *.FGD 
files.    Folder Guard places information in FGuard.unm which helps FGuard.VxD determine which FGD 
file should be used for each user to perform the protection of folders.    If you see this file in the working 
folder, do not modify or delete it. 



 FGuard.adm
File FGuard.adm contains templates for the Windows 95 System Policy Editor.    You can use 
FGuard.adm to control some settings of Folder Guard with the System Policy Editor, and to automate 
setting up Folder Guard on multiple computers in a network.

To use this file, you must first install System Policies, and merge the FGuard.adm file with the active 
template file. You can merge these two files using any plain text editor, such as Notepad:

· Run Notepad and open the active template file (usually C:\Windows\Inf\Admin.ADM —    you can 
determine the active template file by running the System Policy Editor and choosing the Options - 
Template command in its menu).

· Run another instance of Notepad and open the FGuard.adm file.    At this step, your screen should 
display two open Notepad windows.

· FGuard.adm contains two sections, CLASS MACHINE and CLASS USER.    Merge these sections 
with the appropriate sections of the active template file (by copying them onto the Clipboard and 
pasting into the second Notepad window).

 
· Save the active template file and close both Notepad windows.

Note: If you have set up the logon password for Default user, you must enter the (encoded) password into the 
active template file before using its “Allow logon as Default user” option.    The encoded password for the Default 
user is placed by Folder Guard into the local Registry, in the variable “DefUserData”, under the key 
HKEY_LOCAL_MACHINE\ System\ CurrentControlSet\ Services\ Folder Guard\ NetworkProvider.    Refer to the 
comments in the FGuard.adm file for instructions on adding the encoded password to the template file.    

Now run the System Policy Editor and choose File - Open Registry, or open the active policy file.    Both 
the “Local User” and the “Local Computer” entries should now have additional sets of settings, in the 
“Chaosoft - Folder Guard” branches.



 REGISTRY.BAT
REGISTRY.BAT is a simple MS-DOS batch command file, which you can use to automate the process of 
backing up and restoring the Windows 95 Registry.

Syntax:

REGISTRY
displays information on using the utility.

REGISTRY BACKUP
backs up the Registry files.

REGISTRY RESTORE
restores the Registry files.

The commands above should be entered at the MS-DOS command prompt, after rebooting Windows 95 
in the “command prompt only” mode.    (This batch file will refuse to run if invoked from a MS-DOS 
window while Windows 95 is running).    To simplify your work, Folder Guard includes two PIF files, which 
supply the required arguments to the batch file:

Reg_b.pif (Installed as “Registry Backup” in Start menu)
switches Windows to the MS-DOS mode and invokes REGISTRY BACKUP.

Reg_r.pif (Installed as “Registry Restore” in Start menu)
switches Windows to the MS-DOS mode and invokes REGISTRY RESTORE.

Before using this batch file, you may wish to review it and change the variables it uses.    REGISTRY.BAT 
defines and then uses the following variables:

_WINDIR_ Default: C:\WINDOWS
should contain the complete path to the folder in which Windows 95 is installed.    When you run 
REGISTRY.BAT, it verifies that this variable contains a valid path before performing the work.    This 
variable is used when locating the System.dat and User.dat files.

_BACKUPDIR_ Default: C:\REGBKUP
should contain the complete path to the folder in which you want to create copies of the Registry files. 
If this folder does not exist when you back up the Registry, REGISTRY.BAT creates it.    If this folder 
does not exist when you restore the Registry, REGISTRY.BAT displays an error message.

_PROFILESDIR_ Default: %_WINDIR_%\Profiles
should contain the complete path to the root folder in which you keep the user profiles.    If this 
variable points to a folder which does not exist when you run REGISTRY.BAT, the utility displays an 
error message.    This variable is used when locating the user-specific User.dat files.    If you don’t use
user profiles, or want to skip their processing, set this variable to contain a single underscore 
character (“_”). 

You can modify the contents of the REGISTRY.BAT file with any plain text editor, such as Notepad.



 How Folder Guard initializes system folders
Whenever you use Folder Guard to create a new FGA file, Folder Guard assigns the “default” attributes 
to all folders.    If the Preset system folders option is turned on, Folder Guard also assigns the “Full 
access” and “Visible” attributes to the following folders:

· The folder in which Windows 95 is installed (usually C:\Windows).
· The Windows 95 system folder (usually C:\Windows\System).
· Any folder in the root folders which has the “system” attribute assigned by Windows 95 (such as C:\

Recycled).
· Any subfolder of the C:\Windows folder which has the “system” attribute assigned by Windows 95 

(such as C:\Windows\Fonts). 

Folder Guard does this to prevent you from inadvertently restricting access to these folders, since 
Windows 95 uses them during its operation. You may change these attributes, if you wish, although we do
not recommend doing so. Always backup the Registrybefore experimenting with these folders!



 How FGuard.VxD searches for the FGD file(s)
FGuard.VxD first attempts to read the string variable “FGD” in the local Registry, under the key: 

HKEY_CURRENT_USER\ Software\ ChaoSoft\ FGD. 

If this variable contains the DOS path to an FGD file, FGuard.VxD uses this file to perform the protection 
of folders for this user.

Note: Folder Guard does not set up this variable, so it usually does not exists.    You may, however, set up this 
variable (using file FGuard.adm with the Windows 95 System Policy Editor, for example), to force FGuard.VxD 
use a specific FGD file for a particular user. 

If the previous step fails, FGuard.VxD determines the name of the user currently logged on to Windows 
95 and looks for the FGD file with the same name in the working folder.

If the previous step fails, FGuard.VxD uses the “Default.FGD” file (in the working folder) to perform the 
protection of folders.



 How FGuard.VxD searches for the licensing information
FGuard.VxD first attempts to find the licensing information in the local Registry, under the key:

HKEY_LOCAL_MACHINE\ Software\ ChaoSoft\ Folder Guard\ Setup

If this key exists, FGuard.VxD reads the values of the following string variables: "Registered To", "Number
of Users", and "Registration Code". FGuard.VxD then verifies the validity of the Registration Code.

If the previous step fails, FGuard.VxD attempts to find the registration information in file FGuard.lic, which 
is assumed to be located in the working folder. 



 How Folder Guard validates user name at logon
If you enable the Validate user name option, Folder Guard checks the user name against the list of users 
known to Windows 95.    This list is maintained by Windows 95 in the Registry, under the key:

HKEY_LOCAL_MACHINE\ Software\ Microsoft\ Windows\ CurrentVersion\ ProfileList

Each user is represented by a separate subkey under this key.    Windows 95 creates such a subkey 
automatically when the user logs onto the computer for the first time.    

If the user name entered at the logon prompt matches the name of one of the subkeys, the user name is 
considered valid.    If none of the subkeys has the same name as the name entered by the user at the 
logon prompt, the name is considered invalid.



 How to backup the Windows 95 Registry
The Registry is a very important part of Windows 95.    It is a place where Windows 95 stores information 
about hardware and software installed on your computer.    Whenever you add or remove a device, install 
a new software product, change a device settings, modify options for a program — all these changes (and
others, too) are written by Windows 95 into the Registry. 

Physically, the Registry consists of a number of files. To backup the Registry, you must backup its key 
files.    The following two files are the core components of the Registry; they are always present in the 
Windows 95 folder (usually, C:\Windows):

System.dat
contains mostly information about the hardware configuration of the computer. 

 
User.dat

contains mostly information about the software installed on the computer. 
 
In addition, if user profiles are enabled, the user-specific parts of the Registry are stored in separate 
User.dat files, one per user.    (These files are usually located in folders C:\Windows\Profiles\
<user_name>.)    Whenever a user logs on the system, Windows 95 restores the specific settings for this 
user by merging the user-specific User.dat file with the “generic” User.dat file.

It is important to backup the Registry before making any significant changes to your system.    You can 
backup the Registry by making copies of the files mentioned above.    If you need to restore the Registry, 
replace its existing files with the copies you have saved during backup.    You can manually perform these 
operations, or you may wish to use the REGISTRY.BAT utility supplied with Folder Guard.

For more information about the Registry, please consult your Windows 95 documentation. 



 How to enable user profiles on a stand-alone computer
Please note that features described here are built-in into Windows 95 and are NOT provided by Folder 
Guard.    The information below is provided only for reference purposes for your convenience.    If you 
have any questions regarding the features described below, you should contact the technical support 
department of Microsoft, NOT Chaosoft.

This section describes how to enable user profiles on a stand-alone computer, not connected to a 
network.    For complete information please refer to the Windows 95 Resource Kit.

· Step 1. Backup the registry, in case of emergency.

· Step 2. Prepare the Desktop: arrange folders and shortcuts on the Desktop as you want them to 
appear for the user when this user first logs on to Windows 95 under his or her own name.    Move 
those items which you don’t want to be used by other users into a separate folder somewhere on 
your hard disk; later, you will be able to return them to your personal Desktop, when you log on under 
your own name.    Do the same with the Start Menu; its contents is mainained by Windows 95 (usually
in the C:\Windows\Start Menu folder).

· Step 3. Enable user profiles:    Open the Control Panel and double-click on “Passwords”.    In the 
dialog box, select the “User Profiles” page and check the “Users can customize their preferences and
desktop settings” option.    Also check both options in the “User Profile settings” group, on the same 
page.    Press OK and restart Windows 95.

· Step 4. Create user profiles:    When Windows 95 reboots, enter your name and password at the 
logon prompt and let Windows 95 save your personalized settings for future use.    Log off and repeat 
this procedure for all other users of your computer.    You may also wish to create a profile for a 
“Guest” user, just in case.

· Step 5. Restore your Desktop and Start Menu:    log on under your own name and move all items 
you’ve saved while performing Step 2 back to your Desktop and Start Menu.

Now you can run Folder Guard and set up folder attributes and permissions as desired for each user. 



 A Crash Course in System Policies
Please note that features described here are built-in into Windows 95 and are NOT provided by Folder 
Guard.    The information below is provided only for reference purposes for your convenience.    If you 
have any questions regarding the features described below, you should contact the technical support 
department of Microsoft, NOT Chaosoft.

System Policies is an optional component of Windows 95 which you can use to enforce some Windows 
95 settings on the per-user basis.    For complete information on installing and using System Policies, 
consult the Windows 95 Resource Kit.

To make System Policies work on your computer, you must first install them on your computer:

· Insert your Windows 95 CD into the CD-ROM drive.
· Open Control Panel, double click on “Add/Remove Programs”, select the “Windows Setup” page, 

and click on “Have disk” button.
· Enter the following path into the dialog box: D:\ADMIN\APPTOOLS\POLEDIT\POLEDIT.INF (replace 

D: with the drive letter that designates your CD-ROM) and click on OK.

The System Policy Editor uses files of two kinds: template files (extension ADM) and policy files 
(extension POL). Template files contain information that guides the System Policy Editor in modifying the 
Registry in response to your commands.    Policy files contain the restrictions you are setting up for each 
user and computer. 

After you have installed System Policies, run the System Policy Editor, choose the Options - Template 
command in its menu, and select the template file you want to be active (usually it is ADMIN.ADM; often 
this file is installed in the C:\Windows\Inf folder). 

Now create a policy file: 

· Run the System Policy Editor and choose File - New in its menu.
· Use commands of the System Policy Editor to create entries for users of your computer and set up 

their policies. 
· Choose File - Save and save the file.    You may wish to name the file CONFIG.POL and save it in the 

Windows 95 folder (usually, C:\Windows), although you are free to select other name and location for 
this file. 

Finally, you must activate the policy file you have just created.    On a stand-alone computer, do the 
following:

· Run the System Policy Editor and choose File - Open Registry in its menu.
· Open the “Local Computer” item and find the following entry: Network - Update - Remote Update. 

Check this checkbox.
· In the “Settings for Remote Update” area (at the bottom of the same dialog box), specify the following

information:

Update Mode: Manual 

Path for manual update: (enter here the path to the Policy file you wish to be active; for example: “C:\
WINDOWS\CONFIG.POL”, omitting the quotation marks).

· Press OK to close the dialog and choose the File - Save command in the menu to save the changes 
to the Registry.



Note: The path to the active policy file is stored in the Registry in the variable “NetworkPath”, under the key:

HKEY_LOCAL_MACHINE\ System\ CurrentControlSet\ Control\ Update

From now on, whenever a user logs on to Windows 95, the restrictions you have specified in the policy 
file will be applied to the user’s settings.



 MSDOS.SYS: Useful commands
Please note that features described here are built-in into Windows 95 and are NOT provided by Folder 
Guard.    The information below is provided only for reference purposes for your convenience.    If you 
have any questions regarding the features described below, you should contact the technical support 
department of Microsoft, NOT Chaosoft.

In Windows 95, MSDOS.SYS is a text file which may be used to control the boot process. It contains a 
[Paths] section that lists the locations for other Windows 95 files (such as the Registry) and an [Options] 
section that you can use to control the boot process. 

If you want to change any of the values in the MSDOS.SYS file, you can use any plain text editor (like 
Notepad).

IMPORTANT:    Before you edit the MSDOS.SYS file, you should first make a backup copy of it.    The 
original file is located in the root folder of your boot drive.    If you delete the MSDOS.SYS file, your 
computer will not start.    Also, make sure you can boot your computer with a floppy disk, and that the disk 
contains a plain text editor — one you can use to modify the MSDOS.SYS file, if anything goes wrong.

The [Options] section can contain the following settings:

BootDelay=<Seconds> Default:    2
Sets the amount of time the "Starting Windows 95" message remains on the screen before Windows 
95 continues to boot.    If this setting is 0, then you will NOT be able to press the F8 key when 
"Starting Windows 95" appears to invoke the Startup menu.

BootSafe=<Boolean> Default:    0
A setting of 1 forces your computer to boot in safe mode.

BootGUI=<Boolean> Default:    1
A setting of 1 forces the loading of the GUI interface.    A setting of 0 disables the loading of the GUI 
interface.

BootKeys=<Boolean> Default:    1
A setting of 1 enables the use of the function key boot options (that is, F4, F5, F6, and F8). A setting 
of 0 disables the use of these function keys during the boot process. 
Note: A setting of BootKeys=0 overrides the use of BootDelay=n.

BootMenu=<Boolean> Default:    0
A setting of 1 enables the Startup menu.    If this setting is 0, then you must press the F8 key when 
"Starting Windows 95" appears to invoke the Startup menu.

BootMenuDefault=<Number>
Default: 1 if the system is running correctly, 3 if the system hung in the previous instance.
Use this setting to set the default menu item for startup.

 

BootMenuDelay=<Number> Default:    30
This setting is used to set the number of seconds your system will pause on the Startup menu. If the 
number of seconds counts down to 0 without intervention, the BootMenuDefault is activated. 
NOTE: This option will not function unless BootMenu=1 has been specified.

BootMulti=<Boolean> Default:    0



A setting of 0 disables the multi-boot option. (For example, with a setting of 0 you cannot boot your 
previous operating system.)    A setting of 1 enables the F4 and F8 keys to boot your previous 
operating system. 
Note: This setting is set to 0 by default to prevent you from inadvertently starting MS-DOS and 
damaging data by running a disk utility that does not recognize long file names.

BootWarn=<Boolean> Default:    1
A setting of 0 disables the safe mode boot warning message and the Startup menu.

BootWin=<Boolean> Default:    1
A setting of 1 forces Windows 95 to load at startup.    A setting of 0 disables Windows 95 as your 
default operating system (this is useful only if you have MS-DOS version 5.x or 6.x on the computer). 
Note: Pressing F4 inverts the default only if BootMulti=1. (For example, pressing the F4 key with a 
setting of 0 forces Windows 95 to load.)

DBLSpace=<Boolean>Default:    1
A setting of 1 allows the automatic loading of the DBLSPACE.BIN file.    A setting of 0 prevents the 
automatic loading of this file.

DRVSpace=<Boolean>Default:    1
A setting of 1 allows the automatic loading of the DRVSPACE.BIN file.    A setting of 0 prevents the 
automatic loading of this file.

Note: Windows 95 uses either Dblspace.bin or Drvspace.bin if either is present in the root folder of 
the boot drive at startup. To prevent a compression driver from being loaded at startup, use both 
settings in the MSDOS.SYS file. For example:

DBLSpace=0
DRVSpace=0

Logo=<Boolean> Default:    1
A setting of 1 forces the default Windows 95 logo to appear.    A setting of 0 prevents the animated 
logo from being displayed. 

Network=<Boolean> Default:    0
A setting of 1 means the network was installed and adds "Safe mode with network support" as an 
option on the Windows 95 Startup menu.

The MSDOS.SYS file also contains a section with seemingly useless information.    These entries are 
required for compatibility with programs that expect MSDOS.SYS to be at least 1024 bytes in length.    For
example, if an anti-virus scanner detects that MSDOS.SYS is smaller than 1024 bytes, it may assume 
that a virus has infected this file. 



  Can I upgrade to Folder Guard from FM Guard ?

Yes, if you are a registered user of our utility “File Manager Guard for Windows 3.1x” (also known as FM 
Guard) you may register Folder Guard for Windows 95 at a discount price.    Please refer to file Order.txt 
for more information.



  How do I enter the Registration Code ?

You are prompted to enter your name and Registration Code at the end of the installation procedure.

Alternatively, choose the Help - About command of Folder Guard, and click on the “Register” button in 
the dialog box.

Related topics:
This is "Try Before You Buy" software
What do you get when you order a license for Folder Guard
How to order a license for continued use of Folder Guard



  How do I determine the status of folder protection?

If you are running Folder Guard, the status of the protection is indicated by the state of the “Toggle Folder

Protection” button in the toolbar:  . If this button is pressed, the folder protection is currently enabled. 
If the button is not pressed, the folder protection is currently disabled. 

If you are not running Folder Guard, you can determine the status of the protection by running FGKey.exe
(represented by the “Toggle Folder Protection” command in the Windows Start Menu):    If you are 
prompted to enable the protection — it is currently not enabled. If, however, you are prompted to enter a 
password to disable the protection, the protection is currently in effect.



  Will Folder Guard slow down my computer?

Folder Guard is designed to perform the protection of folders with minimum overhead.    You will not notice
any decrease of performance of your computer, unless you assign separate folder attributes to thousands
of folders.    If you are concerned about the performance, try to reduce the number of folders which have 
non-default attributes.    For example, instead of assigning the “hidden” attribute to a group of subfolders 
of the same parent folder, make the parent folder “hidden” instead.      



  How do I rename a folder in the Folder Guard window?

You cannot rename or otherwise manipulate (copy, move, delete) folders or files with Folder Guard.    If 
you want to rename/copy/move/delete a folder, you must do it with Explorer.    To force Folder Guard to 
update its listing of folders in the main window, use its View - Refresh command (or press F5). 



  How do I hide drive icons?

Windows treats the root folders of the drives and drives themselves as separate items.    When you use 
Folder Guard to assign the “Hidden” attribute to a drive, you are hiding the root folder of the drive, but not
the drive itself.

To hide the drive icons, use the Edit - Permissions command of Folder Guard.



  Can I hide the “My Computer” folder?

Unfortunately, Windows 95 does not provide a way to hide this folder alone.    You can only hide all items 
on your Desktop as a group, by using the Edit - Permissions command of Folder Guard.    

If you assign the “Hidden” attribute to “My Computer” using Folder Guard, this attribute will be applied to 
the root folders of the drives, but not to “My Computer” itself.    This is a limitation of the current 
implementation of Windows 95.



  I forgot the password...

If you forget the folder access password or the logon password for the Default User, then the only way to 
solve the problem is to set up a new password — by running Folder Guard and using its appropriate 
commands. 

If you forgot the Administrator’s password and therefore cannot run Folder Guard, you must delete the 
FGuard.cfg file in the folder from which you run FGuard.exe (usually it is located in the folder in which you
have installed Folder Guard).    Be aware, however, that this will also reset all other settings of Folder 
Guard (such as the active FGA file and the working folder) to their defaults.    You will therefore need to 
manually change these settings.

If you cannot delete the FGuard.cfg file (for example, because it is protected by Folder Guard), you must 
boot Windows 95 in the “safe” or “command prompt only” mode.    The folder protection is not enabled in 
either of these modes, so you will be able to delete FGuard.cfg.



  How can I get printed documentation for Folder Guard?

The documentation for Folder Guard is available only in the on-line form — as the Help file you are 
reading now.

You can print out the Help, though:    just press the “Print...” button in the Help Topics dialog box, 
(displayed after you click the Contents button while browsing Folder Guard Help). 






